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EDITORIAL
This magazine was created using :

WELCOME TO THE LATEST ISSUE OF FULL CIRCLE

O

nce again, we have the usual suspects of Python, Inkscape, Krita and Rawtherapee. To
complete the HowTo trilogy we have a new series on creating podcasts in Linux. Written by
Tony Hughes of the Linux Mint MintCast team. And they know a thing or two about podcasting.
Unfortunately, nothing this month from Richard (Everyday Ubuntu). He's a bit under the
weather. Feel free to send him good wishes at: acer11kubuntu@gmail.com
Rounding oﬀ our reviews of 20.04 we have Ubuntu Unity. Yes, Ubuntu with Unity. Even though,
technically, Unity (the dash) doesn't exist anyone. It was renamed to Lomiri, and only really used in
Ubports (Ubuntu) Touch. Until now. So, if you still want Ubuntu with Unity, this might be it. And if
that's not confusing enough, it's not even an oﬃcial 'ﬂavor'. Yet. I'm sure it will be though.
Well, that's about it from me for this month.

Find Full Circle on:
facebook.com/
fullcirclemagazine
twitter.com/#!/fullcirclemag
http://issuu.com/
fullcirclemagazine

Stay safe and well!
All the best, and keep in touch!
Ronnie
ronnie@fullcirclemagazine.org

https://mastodon.social/
@fullcirclemagazine

Weekly News:
http://fullcirclemagazine.org/
feed/podcast
http://www.stitcher.com/s?
ﬁd=85347&reﬁd=stpr

FCM PATREON : https://www.patreon.com/fullcirclemagazine
full circle magazine #159
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http://tunein.com/radio/FullCircle-Weekly-News-p855064/
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Submitted by ErikTheUnready

ROLLING RHINO, A SCRIPT
FOR USING ROLLING UPDATES
IN

https://twitter.com/m_wimpress/
status/1277323423652421632

UBUNTU
06/29/2020

M

artin Wimpres, who served as
director of development of
desktop systems in Canonical, has
proposed a shell script RollingRhino, which allows Ubuntu to
emulate a system with a rollingupdate, which can be useful for
advanced users or developers who
need to be aware of all the
changes. The script automates the
translation of installations of
experimental releases of Ubuntu to
the use of devel-branches of
repositories, which packages with
new versions of applications are
built (synchronized with Debian
Sid / Unstable).
It supports the conversion of
daily experimental builds with
Ubuntu Desktop, Kubuntu,
Lubuntu, Budgie, MATE, Studio and
Xubuntu, which currently reﬂect
the development of the future
release of Ubuntu 20.10

OPEN GAMES: WARZONE
2100 AND PROJECT
OPENDIABLO2
06/29/2020

A

fter 10 months of
development, release 3.4.0 of
the free real-time strategy game
Warzone 2100 is out. The game was
originally developed by Pumpkin
Studios and was launched in 1999.
In 2004, the original code was
discovered and released under the
GPLv2 license. The game continued
with community-driven
development. It supports both a
single game against bots and
network games. Packages are
available for Ubuntu 18.04 / 20.04,
Windows and macOS. Compared to
the previous release, 485 changes
were made!
In addition, the OpenDiablo2
project , which attempts to
recreate the engine of Diablo 2,
released in 2000 by Blizzard
full circle magazine #159

Entertainment, is out. Currently,
the development team's eﬀorts are
focused on developing the
functionality necessary to launch
Diablo 2 (original game resources
from Diablo 2 are required), but in
the future the project will be
expanded with tools for creating
mods and providing an engine for
writing new games. The
implementation code is written in
Go and distributed under the
GPLv3 license.
https://opendiablo2.com/
https://forums.wz2100.net/
viewtopic.php?f=1&t=15905

GNUCASH 4.0
06/29/2020

T

he release of GnuCash 4.0,
which provides tools for
tracking income and expenses,
maintaining bank accounts,
managing information about
stocks, deposits and investments,
and loan planning, was announced.
It is possible to maintain
accounting records for small
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enterprises using GNU Cash. It
supports the import of data in QIF /
OFX / HBCI formats and visual
presentation of information on
graphs. The project code is licensed
under GPLv2 +. There is also a
GnuCash option for Android.
This new release introduces the
gnucash-cli utility, which allows you
to perform various ﬁnancial
functions, such as updating a price
list and generating reports, on the
command line without launching a
graphical interface. A new dialogue
"Transaction Association" was
proposed and the possibility of
adding associations to accounts,
reversal postings, invoices and
vouchers is implemented.
https://lists.gnucash.org/pipermail/
gnucash-announce/2020-June/
000324.html
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NEED HOSTING FOR YOUR
FREE PROJECT?? NONPROFIT PROVIDER FOSSHOST

FossHost virtual servers.
https://fosshost.org/

A

Existing free projects with an
active community and a site or
page on GitHub, are free to get
their hands on a virtual server with
4 vCPU, 4GB RAM, 200GB storage
and IPv4 and IPv6 addresses. It is
possible to register domains of the
second level and organize the work
of mirrors. Management is through
SSH. Supports installation of
CentOS, Debian, Ubuntu, Gentoo,
ArchLinux, Fedora, and FreeBSD. It
is noted that such open projects as
ActivityPub (W3), Manjaro, XFCE,
Xubuntu, GNOME and Xiph.Org
have already taken advantage of

LANGUAGE RELEASE
06/30/2020

06/29/2020
s part of the FossHost project,
the work of a non-proﬁt
provider that provides free virtual
servers for free projects was
organized. Currently, the project
infrastructure includes 7 servers
deployed in the USA, Poland, Great
Britain and the Netherlands based
on the ProxMox VE 6.2 platform .
Equipment and infrastructure is
provided by FossHost sponsors,
and activities are carried out by
enthusiasts.

LUA 5.4 PROGRAMMING

REDIS DBMS CREATOR
HANDED OVER PROJECT
SUPPORT TO COMMUNITY
06/30/2020

S

alvatore Sanﬁlippo, creator of
the Redis DBMS, announced
that he would no longer be
involved in project maintenance
and would devote his time to
something else. According to
Salvatore, in recent years his work
has come down to parsing thirdparty proposals for improving and
changing the code, but this is not
what he would like to do, since he
likes writing code and creating
something new rather than solving
routine maintenance tasks. El
Salvatore will remain on the
advisory board of Redis Labs, but
will be limited to generating ideas.
Development and maintenance are
handed over to the community.
http://antirez.com/news/133
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A

fter ﬁve years of
development , the release of
Lua 5.4 , a fast and compact
scripting programming language, is
widely used as an embedded
language (for example, to
determine the conﬁguration or to
write extensions). The Lua
interpreter code is written in C and
distributed under the MIT license.
Lua combines simple procedural
syntax with powerful data
description capabilities through the
use of associative arrays and
extensible language semantics. Lua
uses dynamic typing; language
constructs are converted to
bytecode running on top of a
register virtual machine with an
automatic garbage collector. The
interpreter itself is designed as a
library that is easily integrated into
projects in C and C++.
https://www.lua.org/news.html
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SHOTCUT VIDEO EDITOR
RELEASE 06/20
07/01/2020

T

he release of the video editor
Shotcut 20.06 is published,
which is developed by the author
of the MLT project and uses this
framework for organizing video
editing. Support for video and
audio formats is implemented
through FFmpeg. You can use plugins with the implementation of
video and audio eﬀects compatible
with Frei0r and LADSPA . Among
the features of Shotcut, we can
note the possibility of multi-track
editing with the composition of
video from fragments in various
source formats, without the need
for their preliminary import or
transcoding. There are built-in tools
for creating screencasts,
processing images from a webcam
and receiving streaming video. To
build the interface, Qt5 is used.
Code written in C ++ and
distributed under the GPLv3
license.
https://www.shotcut.org/blog/
new-release-200628/
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FEDORA CONSIDERS
DISCONTINUING BIOS
SUPPORT AT BOOT TIME
07/01/2020

F

edora developers are discussing
the issue of stopping the boot
using the classic BIOS and leaving
the option to install only on
systems that support UEFI. It is
noted that systems based on the
Intel platform have been shipped
with UEFI since 2005, and by 2020
Intel planned to stop supporting
BIOS in client systems and data
center platforms.
The discussion of the rejection
of BIOS support in Fedora is also
due to the simpliﬁcation of the
implementation of the technology
of selective display of the boot
menu, in which the menu is hidden
by default and is shown only after a
failure or activation of the option
in GNOME. For UEFI, the necessary
functionality is already available in
sd-boot, but when using the BIOS it
requires patches for GRUB2.

GPARTED LIVE 1.1.0-3

6TYTCD/

DISTRIBUTION RELEASED:

OPENSUSE LEAP 15.2
DISTRIBUTION RELEASE
07/02/2020

A

fter more than a year of
development, the openSUSE
Leap 15.2 distribution has been
released. The release is formed
using the basic set of packages
from the SUSE Linux Enterprise 15
SP2 distribution under
development, on top of which
newer releases of user applications
from the openSUSE Tumbleweed
repository are delivered. A
universal 4-GB DVD assembly is
available for download , a strippeddown image for installation with
downloading packages over the
network (138 MB) and Liveassemblies with KDE (910 MB) and
GNOME (820 MB).
https://www.opensuse.org/

https://lists.fedoraproject.org/
archives/list/
devel@lists.fedoraproject.org/
thread/
QBANCA2UAJ5ZSMDVVARLIYAJE6

07/03/2020

T

he release of the GParted
LiveCD LiveCD 1.1.0-3
distribution kit is available, aimed
at restoring the system after a
failure and working with disk
partitions using the Parted
partition editor. The distribution is
based on the Debian Sid package
base as of July 1. The boot image
size is 382 MB (amd64, i686).
The distribution package
includes the GParted 1.1.0 package,
in which the faster utilities minfo
and mdir are used to read
information about FAT16 / 32
partitions, a more accurate
calculation of the JFS size is
provided, recognition of drives
included in ATARAID is
implemented, and their
employment status is determined.
The Linux kernel has been updated
to release 5.7.6. Solved the
problem with the crash of the
Netsurf browser on some sites.
https://gparted.org/news.php?
item=232
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GOOGLE IS WORKING ON
STEAM SUPPORT ON
CHROME OS THROUGH AN
UBUNTU VIRTUAL MACHINE
07/03/2020

G

oogle is developing the
Borealis project, which aims to
provide Chrome OS with the ability
to launch gaming applications
distributed via Steam. The
implementation is based on the use
of a virtual machine in which the
components of the Ubuntu Linux
18.04 distribution kit are launched
with the Steam client preinstalled
and the Wine-based package for
launching Proton Windows games.
The environment is undergoing
internal testing on hi-end
Chromebooks equipped with the
10th generation of Intel
processors. So far, the Crostini
Linux environment oﬀered by
Chrome OS has been shipped with
Debian, which is also used as the
basis for Valve's SteamOS
distribution.
https://9to5google.com/
2020/07/01/chrome-os-preparingsteam-gaming-ubuntu/
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ELEMENTARY OS 5.1.6
DISTRIBUTION UPDATE
07/03/2020

P

resented is the release of the
Elementary OS 5.1.6
distribution, positioned as a fast,
open and privacy-conscious
alternative to Windows and macOS.
The main focus of the project is on
high-quality design, aimed at
creating an easy-to-use system that
consumes minimal resources and
ensures high startup speed. Users
are oﬀered their own desktop
environment, Pantheon.
The original components of
Elementary OS are developed
using GTK3, Vala, and its own
Granite framework.
https://blog.elementary.io/
updates-for-june-2020/

UBUNTU 20.10 WILL
RESTRICT ACCESS TO DMESG:
07/03/2020

U

buntu developers have agreed
to restrict access to the /usr/
bin/dmesg utility only for users in

the adm group. Currently,
unprivileged Ubuntu users do not
have access to /var/log/kern.log, /
var/log/syslog and system events in
journalctl, but can view the kernel
event log through dmesg.
As a reason, the presence in the
dmesg output of information that
can be used by attackers to simplify
the creation of exploits to increase
privileges is mentioned. For
example, in dmesg, in case of
failures, a stack dump is displayed
and it is possible to determine the
addresses of structures in the
kernel, which can help bypass the
KASLR mechanism. An attacker can
use dmesg as feedback, gradually
leading the exploit to its proper
form, watching oops in the log
after unsuccessful attempts to
attack.
https://lists.ubuntu.com/archives/
ubuntu-devel/2020-July/
041079.html

MAXX 2.1 DESKTOP
RELEASE, AN ADAPTATION
OF IRIX INTERACTIVE
DESKTOP FOR LINUX

https://docs.maxxinteractive.com/

T

he release of the MaXX 2.1
desktop is presented, the
developers of which are trying to
recreate the custom shell IRIX
Interactive Desktop (SGI Indigo
Magic Desktop) using Linux
technologies. Development is
under agreement with SGI, which
permits the complete re-creation
of all IRIX Interactive Desktop
features for the Linux platform on
x86_64 and ia64 architectures. The
source code is available upon
special request and is a mixture of
proprietary code (in accordance
with the requirements of the
agreement with SGI) and code
under various open licenses.
Installation instructions are
prepared for Ubuntu, RHEL and
Debian.
Initially, IRIX Interactive Desktop
was shipped on SGI-based graphics
workstations equipped with the
IRIX operating system, which
reached their peak in the late
1990s and were manufactured until
2006. Shell revision for Linux
implemented on top of the 5dwm
window manager (based on the
OpenMotif window manager) and
SGI-Motif libraries.

SENDMAIL SMTP SERVER
RELEASES 8.16.1:
07/05/2020

F

ive years after the last release,
the Sendmail 8.16.1 SMTP
server release was generated . The
new version introduces a large
portion of improvements related to
STARTTLS support (for example,
the ability to use encryption
algorithms based on elliptic curves
has been added), logging has been
improved, new options SSLEngine
and SSLEnginePath for using
OpenSSL engines have been added,
and initial support for DANE (DNSbased Authentication) has been
added of Named Entities). The new
release also ﬁxes bugs and
provides compatibility with Darwin
14-18 (macOS 10.x) and FreeBSD
12.
https://www.proofpoint.com/us/
products/open-source-emailsolution

07/05/2020
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CLONEZILLA LIVE 2.6.7
RELEASED:
07/06/2020

C

lonezilla Live 2.6.7 is available,
designed for fast disk clone
(coping of only used blocks). The
tasks performed by the distribution
are similar to the proprietary
Norton Ghost product. The size of
the ISO image of the distribution is
277 MB (i686, amd64).
The distribution is based on
Debian GNU / Linux and uses the
code of projects such as DRBL,
Partition Image, ntfsclone,
partclone and udpcast in its source.
It can boot from CD / DVD, USB
Flash and over the network (PXE).
LVM2 and FS ext2, ext3, ext4,
reiserfs, reiser4, xfs, jfs, btrfs, f2fs,
nilfs2, FAT12, FAT16, FAT32, NTFS,
HFS +, UFS, minix, VMFS3 and
VMFS5 (VMWare ESX) are
supported. There is a mode of mass
cloning over the network, including
the transfer of traﬃc in multicast
mode, which allows you to
simultaneously clone the source
disk to a large number of client
machines. It is possible to clone
from one disk to another, as well as
create backups by saving the disk
image to a ﬁle. It is possible to

clone at the level of entire disks or
individual partitions.
https://sourceforge.net/p/
clonezilla/news/2020/07/stableclonezilla-live-267-28-released/

NOMADBSD 1.3.2
DISTRIBUTION RELEASED:
07/07/2020

N

omadBSD 1.3.2 Live
distribution is available, which
is a FreeBSD edition adapted for
use as a portable desktop loaded
from a USB drive. The graphical
environment is based on the
Openbox window manager. DSBMD
is used to mount drives (it supports
mounting CD9660, FAT, HFS +,
NTFS, Ext 2/3/4), and wiﬁmgr to
conﬁgure a wireless network . The
boot image size is 2.6 GB (x86_64).
https://nomadbsd.org/
index.html#1.3.2

SEAMONKEY 2.53.3
INTEGRATED INTERNET
APPLICATION LAUNCH:
07/07/2020
full circle magazine #159

T

he SeaMonkey 2.53.3 Internet
application suite has been
released, which combines a web
browser, an email client, a feed
aggregation system (RSS / Atom)
and the Composer WYSIWYG html
page editor, all in one product. In
the form of pre-installed add-ons,
the Chatzilla IRC client, the DOM
Inspector toolkit for web
developers and the Lightning
calendar planner are oﬀered.
Corrections and changes from the
current Firefox code base were
transferred to the new release
(SeaMonkey 2.53 is based on the
Firefox 60 browser engine with
porting security-related ﬁxes and
some improvements from the
current Firefox branches).

revised version of the Reiser4 ﬁle
system, at the ﬁle system level, and
not the block device, support for
parallel scalable logical volumes is
implemented, which allows
eﬃcient distribution of data across
a logical volume.
Previously, data block migration
was carried out exclusively in the
context of balancing the Reiser5
logical volume in order to preserve
fair distribution on it. Now you can
move the data of any ﬁle to any
disk component of the logical
volume. Moreover, you can mark
this ﬁle in a special way so that the
balancing procedure will ignore it,
and, therefore, blocks of its data
will remain on the speciﬁed disk.

https://blog.seamonkey-project.org/ https://marc.info/?l=reiserfs2020/07/07/seamonkey-2-53-3-has- devel&m=159394757714692&w=2
been-released/

REISER5 ANNOUNCES
SUPPORT FOR SELECTIVE
FILE MIGRATION:
07/07/2020

E

duard Shishkin implemented
support for selective ﬁle
migration in Reiser5. As part of the
Reiser5 project, a substantially
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F3D 1.0, A COMPACT
VIEWER OF 3D MODELS:
07/08/2020

C

ompany Kitware, specializing in
the ﬁeld of medical imaging
data and computer vision,
introduced a fast and compact
viewer for 3D-models: F3D 1.0. The
program is written in C++, uses the
contents ^
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VTK visualization library , also
developed by KitWare, and is
distributed under the BSD license.
Builds for Windows, Linux, and
macOS platforms should now be
available.
Display control and navigation
on the resources proposed in the
ﬁle is done through command line
options or hot keys. It supports
viewing 3D models in VTK, STL
(Standard Triangle Language), PLY
(Polygon File format), GML
(CityGML), DCM (DICOM), EX2
(Exodus 2), PTS (Point Cloud), OBJ
(Wavefront), GLTF / GLB (GL), 3DS
(Autodesk 3DS Max) and VRL
(VRML). For gltf / glb, 3ds, wrl, and
obj formats that include scene
information (light sources,
cameras, textures, characters), the
scene speciﬁed in the ﬁle is
displayed, and for formats

containing only geometry
information, a default scene is
generated. OpenGL or the ray
tracing engines available in VTK can
be used for rendering.
https://blog.kitware.com/f3d-v1-0a-fast-and-minimalist-3d-viewerhas-been-released/

GOOGLE AND CANONICAL:
THE ABILITY TO CREATE
DESKTOP APPLICATIONS FOR

LINUX IN FLUTTER:
07/08/2020

G

oogle and Canonical have
taken a joint initiative to
support the development of
graphical applications based on the
Flutter desktop Linux framework.
The Flutter user interface

construction framework is written
in the Dart language (the runtime
engine for executing applications is
written in C ++). It allows creating
universal applications running on
diﬀerent platforms, and is
considered as an alternative to
React Native.
Despite the presence of the
Flutter SDK for Linux, it has so far
been used only for the
development of mobile
applications and did not support
desktop applications for Linux. Last
year, Google announced its
intention to add to Flutter, the
ability to develop full-ﬂedged
desktop programs. Flutter is now
expanded with the ability to
develop desktop applications for
Linux. Support for developing
applications for Windows is still at
the initial prototype stage.

FULL CIRCLE WEEKLY
NEWS

Join our new host Leo
Chavez as he presents you
with a short podcast
(<10min) with just the news.
No chit-chat. No time
wasting. Just the latest
FOSS/Linux/ Ubuntu news.
RSS: http://
fullcirclemagazine.
org/feed/podcast

full circle magazine #159
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https://ubuntu.com//blog/
canonical-enables-linux-desktopapp-support-with-ﬂutter

SUSE ANNOUNCES
RANCHER LABS PURCHASE:
07/08/2020

S

USE, which last year regained
the status of an independent
company, has announced the
purchase of Rancher Labs,
dedicated to the development of
the operating system RancherOS
for insulated containers. It is also
the repository of Longhorn,
Kubernetes-distributions RKE
(Rancher Kubernetes Engine) and
K3S (the Lightweight Kubernetes),
as well as Kubernetes-based
container infrastructure
management tools.
Details of the transaction were
not disclosed, but according to
unoﬃcial information, the amount
of the transaction ranged from 600
to 700 million US dollars. A
detailed plan for integrating
Rancher Labs technologies into
SUSE products will be presented
after regulatory approval of the
transaction.

https://www.suse.com/c/news/
suse-acquires-rancher/

DEBIAN 8.0 "JESSIE"
DISCONTINUED LTS
SUPPORT:
07/09/2020

T

he maintenance period for the
LTS branch of the Debian 8
Jessie distribution, released in
2015, has come to an end. The
release of updates for the LTS
branch was carried out by a
separate group of developers of
the LTS Team, formed from
enthusiasts and representatives of
companies interested in the longterm delivery of updates for
Debian.
The initiative group has already
begun to form a new LTS branch
based on Debian 9 "Stretch", whose
regular support expires on July 18,
2020. The release of updates for
Debian 9 will be extended until
June 30, 2022 (in the future, LTS
support will be provided for Debian
10, updates for which will be
released until 2024). As with
Debian 8, the LTS support for
full circle magazine #159

Debian 9 and Debian 10 will apply
only to the i386, amd64, armel, and
armhf architectures, with a total
support period of 5 years.
https://www.debian.org/News/
2020/20200709

MINETEST 5.3.0 RELEASE,
AN OPEN CLONE OF

MINECRAFT:
07/10/2020

M

inetest 5.3.0, an open crossplatform version of
MineCraft, which allows groups of
players to jointly create various
structures from typical blocks into
a kind of virtual world is out. The
game is written in C++ using the
irrlicht 3D engine. To create your
own extensions, use the Lua
language. Minetest code is
distributed under the LGPL license,
and game resources are licensed
under the CC BY-SA 3.0 license.
Ready-made Minetest builds are
designed for various Linux,
Android, FreeBSD, Windows and
macOS distributions.
https://forum.minetest.net/
viewtopic.php?f=18&t=25044
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SLACKEL 7.3 DISTRIBUTION
RELEASED:
07/10/2020

A

fter a year of development,
Slackel 7.3 distribution, built
on the shoulders of the Slackware
and Salix projects, and fully
compatible with the repositories
they oﬀer, was released. A key
feature of Slackel is the use of the
constantly updated “SlackwareCurrent” branch. The graphical
environment is based on the
Openbox window manager. (So
they say, but it seems more like
LXDE to me) The size of the boot
image that can work in live mode is
1.9 GB (32 and 64 bit). The
distribution can be used on
systems with as little as 512 MB of
RAM.
http://www.slackel.gr/forum/
viewtopic.php?f=3&t=612

JULY KDE APPLICATION
UPDATE 20.04.3
07/10/2020

I

n accordance with the monthly
update publication cycle
contents ^
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introduced last year, the July
consolidated update of
applications (04/20/3) developed
by the KDE project is up for your
perusal. In total, as part of the July
update, releases of more than 120
programs, libraries and plugins
were published.
https://kde.org/announcements/
releases/2020-07-apps-update/

TAUON MUSIC BOX 6.0
MUSIC PLAYER RELEASED:
07/11/2020

T

he Tauon Music Box 6.0 music
player is available, combining a
fast and minimalistic interface with
rich functionality. The project is
written in Python and distributed
under the GPLv3 license. Packages
are prepared for Arch Linux in both
Snap and Flatpak formats .
https://github.com/Taiko2k/
TauonMusicBox/releases/tag/
v6.0.0

WEBTORRENT PROTOCOL
SUPPORT ADDED TO
LIBTORRENT:
07/13/2020

S

upport for the WebTorrent
protocol has been added to the
libtorrent library, which oﬀers an
eﬃcient implementation of the
BitTorrent protocol in terms of
memory consumption and CPU
load. The code for working with
WebTorrent will be included in the
next major release of libtorrent,
after the 2.0 branch. WebTorrent is
an extension of the BitTorrent
protocol. The project does not
require external server
infrastructure and browser plug-ins
to work.
https://feross.org/libtorrentwebtorrent/

NEW VERSION OF CLAWS
MAIL EMAIL CLIENT:
07/13/2020 21:24

T

he easy and fast email client
Claws Mail 3.17.6 is out. In 2005
it separated from the Sylpheed
project (from 2001 to 2005, the
projects were developed jointly,
full circle magazine #159

Claws was used to test future
innovations of Sylpheed). The
Claws Mail interface is built using
GTK, the code is distributed under
the GPL license. A Phishing warning
is now shown when copying a
phishing URL, (in addition to
clicking a phishing URL). However,
in this writer's opinion, it still looks
like it came from 1979 and
seriously needs a facelift.
https://www.claws-mail.org/
news.php

ICEWM 1.7 RELEASED:
07/13/2020

I

ceWM lightweight window
manager release is available.
Notable features of IceWM: full
control through keyboard
combinations, the ability to use
virtual desktops, taskbars and
application menus. The window
manager is conﬁgured through a
set of fairly simple conﬁguration
ﬁles, allowing you to use themes.
Built-in applets are available for
monitoring CPU, memory and
network traﬃc. The code is written
in C ++ and distributed under the
GPLv2 license.
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https://github.com/ice-wm/icewm/
releases/tag/1.7.0

PALE MOON BROWSER
RELEASE:
07/14/2020

P

ale Moon 28.11 web browser, a
fork of the Firefox code base to
provide higher performance,
maintain the classic interface, is
out. Pale Moon binaries are
conﬁgured for Windows and Linux
(x86 and x86_64). The project code
is distributed under the MPLv2
(Mozilla Public License).
The project adheres to the
classic layout of the interface,
without moving to the Australis
interface integrated into Firefox
29, and with the provision of
extensive customization options.
Among the removed components
are DRM, Social API, WebRTC, PDF
viewer, Сrash Reporter, code for
collecting statistics and tools for
parental control.
https://forum.palemoon.org/
viewtopic.php?
t=24760&p=193999#p193999
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SAIL IMAGE DECODING
LIBRARY AVAILABLE
07/14/2020

A

cross-platform SAIL image
decoding library is published
under the MIT license. SAIL is a rebranded C codec from a longunsupported KSquirrel image
viewer, but with a high-level
abstract API and numerous
improvements. Target audience:
image viewers, game development
or loading images into memory for
other purposes. The library is
already usable, but still under
development. Binary compatibility
and source code compatibility are
not guaranteed at this stage of
development.
https://github.com/smoked-herring/
sail

NOKIA UNVEILS SR LINUX
NETWORK OPERATING
SYSTEM FOR ROUTERS
07/14/2020

cloud environments. SR Linux is
seen as a key component of Nokia
Data Center Fabric solutions and
will be installed on Nokia 7250 IXR
and 7220 IXR routers. The SR Linuxbased solution is already being
tested at Apple’s new Danish data
center.
Unlike other operating systems
for network equipment based on
the Linux kernel, SR Linux retains
the ability to access the underlying
Linux environment, which is not
hidden behind specialized APIs and
interfaces. Users have access to the
unmodiﬁed Linux kernel and basic
system applications (bash, cron,
Python, etc.), and speciﬁc
applications are created using the
NetOps Toolkit, which is not tied to
certain programming languages.
https://www.nokia.com/about-us/
news/releases/2020/07/09/nokiaannounces-generational-step-indata-center-networking-new-osand-tools-give-cloud-buildersunprecedented-ability-to-adaptautomate-and-scale/

N

okia has introduced a new
network operating system,
Service Router Linux (SR Linux). It is
focused on data center use and
full circle magazine #159

OTOBO TICKET SYSTEM
RELEASED, A FORK OF OTRS
07/14/2020

R

other OSS introduced the ﬁrst
stable release of the OTOBO
10.0.1 ticket system, a fork of OTRS
CE . The system is designed to solve
such problems as ensuring the
operation of a technical support
service (help desk), managing
responses to customer requests
(phone calls, email), coordinating
the provision of corporate IT
services, managing applications in
sales and ﬁnancial services, all in
one place. OTOBO code is written
in Perl and is distributed under the
GPLv3 license.
Stefan Rother, now the founder
and managing director of Rother
OSS, joined OTRS GmbH (today
OTRS AG) in 2004. In 2011, he
founded his own company, Rother
OSS. By 2019, Rother OSS has
focused on providing business
services related to open source
OTRS options. In response to the
changed OTRS AG release strategy
and the delay in releasing new
versions of the OTRS Community
Edition, Rother OSS began to
develop an OTOBO (Open Ticket
Ours Based Otrs) application
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system based on OTRS version 6.
OTOBO's business concept is to
support business users and
training.
https://otobo.de/en/

NETWORKMANAGER 1.26.0
NETWORK CONFIGURATOR
RELEASED
07/14/2020

A

stable interface release has
been introduced to simplify
the conﬁguration of network
parameters - NetworkManager
1.26.0. Plugins for supporting VPN,
OpenConnect, PPTP, OpenVPN and
OpenSWAN are part of their
development cycles.
https://www.mail-archive.com/
release-team@gnome.org/
msg08516.html

POPCORN WILL BE REMOVED
FROM THE UBUNTU BASE:
07/15/2020

M

ichael Hudson-Doyle of the
Ubuntu Foundations Team
announced a decision to remove
contents ^

NEWS
the popcon (popularity-contest)
package from Ubuntu's core team,
which was used to transmit
anonymous telemetry about
downloading, installing, updating,
and removing packages. Based on
the collected data, reports were
generated on the popularity of
applications and the architectures
used, which were used by
developers to make decisions on
the inclusion of certain programs in
the base delivery. Popcon was
included in the distribution since
2006, but since the release of
Ubuntu 18.04, this package and the
server backend associated with it
have been mothballed.
https://discourse.ubuntu.com/t/
popcon-to-be-removed-from-thestandard-seed/17238

VIRTUALBOX 6.1.12
RELEASED:
07/15/2020

O

racle has released VirtualBox
6.1.12 - virtualization patch
release, which boasts 14 ﬁxes . At
the same time, updates 6.0.24 and
5.2.44 are oﬀered. The new
versions also ﬁx 25 vulnerabilities
not explicitly mentioned in the

changelist.
https://www.mail-archive.com/
vbox-announce@virtualbox.org/
msg00206.html

https://github.com/swaywm/sway/
releases/tag/1.5

ENDEAVOUROS
SWAY 1.5 USER
ENVIRONMENT RELEASED:
07/16/2020

T

he release of the composite
manager Sway 1.5 , built using
the Wayland protocol and fully
compatible with the i3 mosaic
window manager and the i3bar
panel, was heralded. The project
code is written in C and distributed
under the MIT license. The project
aims to be used on Linux as well as
FreeBSD.
Compatibility with i3 is ensured
at the command level,
conﬁguration ﬁles and IPC, which
allows you to use Sway as a
transparent replacement for i3,
using Wayland instead of X11. Sway
allows you to place windows on the
screen not spatially, but logically.
The windows are arranged to form
a grid that optimally uses the
screen real estate and allows you
to quickly manipulate the windows
only using the keyboard.
full circle magazine #159

DISTRIBUTION KIT:
07/16/2020

E

ndeavourOS 2020.07.15, which
replaced Antergos,
(development has been
discontinued in May 2019) is
available. The distribution oﬀers a
simple installer for installing the
base Arch Linux environment with
the default Xfce desktop and the
ability to install one of 9 typical
desktops based on i3-wm,
Openbox, Mate, Cinnamon,
GNOME, Deepin, Budgie and KDE.
Endeavor OS allows the user to
easily install Arch Linux with the
necessary desktop in the way that
it was meant, by the developers of
the selected desktop, without
additional pre-installed programs.
Installation image size 1.7 GB
(x86_64).
https://endeavouros.com/news/
our-ﬁrst-anniversary-the-julyrelease-and-whats-next/
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THUNDERBIRD 78 EMAIL
CLIENT EDITION:
07/17/2020

1

1 months after the publication
of the last major release,
Thunderbird 78, developed by the
community and based on Mozilla
technologies, was released. The
new release is categorized as a
version with a long support period,
for which updates are issued during
the year. Thunderbird 78 is based
on the source of Firefox 78 ESR.
The release is available only for
direct download, automatic
updating from previous releases to
version 78.0 is not provided and
will be available only in version
78.2.
https://blog.thunderbird.net/
2020/07/whats-new-inthunderbird-78/

CLAMAV 0.102.4 FREE
ANTIVIRUS PACKAGE
UPDATE:
07/17/2020

T

he free anti-virus package
ClamAV 0.102.4 is out, in which
three vulnerabilities have been
contents ^
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ﬁxed: CVE-2020-3350, CVE-20203327, CVE-2020-3481
https://blog.clamav.net/2020/07/
clamav-01024-security-patchreleased.html

https://github.com/microsoft/
ProcMon-for-Linux

07/18/2020

RELEASE OF CMAKE BUILD
SYSTEM 3.18:
07/18/2020

MICROSOFT HAS PUBLISHED
AN OPEN LINUX VERSION OF
THE MONITORING UTILITY

PROCMON:
07/17/2020

M

icrosoft has, under MIT
license, published the source
code for the ProcMon utility
(Process Monitor) for Linux.
Initially, the utility was supplied in
the Sysinternals suite for Windows
and is now adapted for Linux.
Tracing in Linux is organized using
the BCC toolkit (BPF Compiler
Collection), which allows you to
create eﬀective BPF programs for
tracing and manipulating kernel
structures. Ready-to-install
packages are built for Ubuntu
Linux. The utility provides a simple
console interface for monitoring
the status of processes in the
system and analyzing the activity
of accessing system calls.

DEBIAN FINAL UPDATE 9.13:

T

he release of the crossplatform open source script
generator CMake 3.18, acting as an
alternative to Autotools and used
in projects such as KDE, LLVM /
Clang, MySQL, MariaDB, ReactOS
and Blender, is out. The CMake
code is written in C++ and is
distributed under the BSD license.
CMake is noted for providing a
simple scripting language,
extensibility through modules,
minimal dependencies (no binding
to M4, Perl, or Python), caching
support, cross-compilation tools,
support for generating build ﬁles
for a wide range of build systems
and compilers, ctest and cpack
utilities for deﬁning test and build
scripts, cmake-gui utility for
interactively conﬁguring build
parameters.
https://blog.kitware.com/cmake-318-0-available-for-download/
full circle magazine #159

A

bug-ﬁx update has been
published for the last stable
branch of Debian 9, which includes
cumulative package updates and
ﬁxes in the installer. The release
includes 75 updates that address
stability issues and 73 updates that
address vulnerabilities. This is the
ﬁnal release of the Debian 9
branch, further building of package
updates will be passed on to the
LTS Team. Native support for
Debian 9 ended on 18 July 2020. As
part of the LTS branch, updates for
Debian 9 will be released until June
30, 2022.
https://www.debian.org/News/
2020/20200718

MIDNIGHT COMMANDER
4.8.25 FILE MANAGER
RELEASED:
07/19/2020

T

his is a maintenance release
including several new features
and ﬁxes for issues found since the
last one. It is now possible to
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change ﬁle attributes via a
graphical dialog, just like ﬁle
permissions. Key bindings for radio
buttons can now be redeﬁned.
Annoying subshell warning when
launching standalone editor &
viewer should be ﬁnally gone.
Other than that, a number of
changes and ﬁxes have taken place
touching various components such
as the build system, syntax
deﬁnitions and so on.
https://mail.gnome.org/archives/
mc-devel/2020-July/
msg00001.html

LAUNCH OF KAOS
2020.07:
07/20/2020

K

aOS 2020.07 is a rolling release
distribution aimed at providing
a desktop based on fresh releases
of KDE and applications using Qt
such as the Calligra oﬃce suite.
The distribution is based on Arch
Linux, but maintains its own
independent repository,
numbering about 1500 packages.
The new release oﬀers KDE
Plasma 5.19.3 desktop, KDE
Applications 20.04.3, Qt 5.15.0,
contents ^
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Mesa 20.1.3, NetworkManager
1.26.0, Linux kernel 5.7.8, etc. The
basic version includes an image
editor Photoﬂare, music player
vvave, etc. The design theme has
been modernized. Support for boot
process themes based on systemdbootloader was added. Whenever
possible, QAM-based modules
were used in the Calamares
installer, including a new QMLmodule for setting keyboard
parameters, and a module for
setting localization is being
developed.

THE OFFICIAL FULL CIRCLE APP FOR UBUNTU TOUCH - UPDATED!

B

rian Douglass has updated his
FCM app for Ubports Touch
devices that will allow you to view
current issues, and back issues, and
to download and view them on your
Ubuntu Touch phone/tablet.

INSTALL
Either search for 'full circle' in the
Open Store and click install, or view
the URL below on your device and
click install to be taken to the store
page:
https://uappexplorer.com/app/
fullcircle.bhdouglass

https://kaosx.us/news/2020/
kaos07/

HUGE thanks to Brian for this.

full circle magazine #159
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Rust Pt.4

Written by Erik

O

kay rustafarians, we head back
to Rust development as
@Daredevil14 and Ellin complained
about where Lucas’ Rust blog
went. It looks like you guys want
more Rust and less ‘security
nonsense’. Firstly, do not neglect
to read the above book. If you are a
complete beginner to Rust or even
programming, we’ve got you
covered here at FCM.

https://doc.rust-lang.org/book/
ch04-01-what-is-ownership.html

At the moment, we are just
taking a high-level view of things.
We can drill down into each of
these topics we have covered in
more detail. If you have been
following Greg’s excellent tutorials,
you would be familiar with local
and global variables. (The scope of
the variables). The thing in Rust is,
every variable has an owner, which
is a variable too. Sounds confusing?
Come read chapter 4.1 with us!

What does it mean to own data?
Why would you need to own data?
Is there a tax to be paid for owning
data? Well, from what I can tell,
there is no performance hit, but
you take a hit in ﬁle size. When you
compile a tiny ‘hello world’ console
application, you end up with 2MB
instead of 2KB. Let me try to break
it down. Each piece of data has an
owner, which is obviously a
variable. That owner is responsible
for cleaning up after that data. The
owner decides if the data can be
changed (is it mutable?) This
“cleanup” happens when the owner
goes out of scope. What do we
mean by this? When you create a
function, you have starting and
ending curly braces. Any variable
within those curly braces has scope
only there, so when your program
steps out of the last curly brace,
the magic happens. Just for those a
bit more curious, that “magic” is
called “drop”.

This will be chapter four in the
book above. This is the direct link:

How about we use a real world
allegory: your friend Tammy has a

These articles are not to replace
the book mentioned above, think
of them more as helpers along the
way.

full circle magazine #159

games night. You bring your
favourite card game, Exploding
Kittens. Everyone else brings their
favourite game too. When you are
done playing Exploding Kittens,
you, as the owner, pick up all the
cards on the table and pack them
back into the container and take it
home with you when you leave. If
you leave the cards lying on the
table, it would make it diﬃcult to
play the next card game. You also
won’t be invited back if you expect
someone else to pack up your cards
after every game. You may have
heard that some programming
languages have “garbage
collection”. This is great, but there
is a performance hit as this
program needs memory and CPU
cycles to clean up automatically
after your mess.
Remember when we declare a
variable in Rust, we have the option
to use the “mut” keyword. Now
obviously, when you change a
variable, its size in memory changes
too, imagine changing a string
“FCM” to this whole article, three
characters vs three thousand. So
the memory allocation can change.
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And that extra may need to be
cleaned up. In the example in the
Rust book, you may have noticed: “
let mut s = String::from("hello"); ” I
am going to oversimplify this, but
hear me out. This now creates data,
say ﬁve bytes, each containing one
character from that string “hello”.
So you have the ﬁrst byte being an
“h”, the next an “e”, and so on. The
“ :: “ notation is new to me too, so
don’t feel left out. For now, simply
do it that way and memorise how it
is used. Don’t worry, if you don’t
understand the references in the
examples in the book, they refer to
other programming language
syntax, to help programmers who
are familiar with those other
programming languages transition
to Rust more smoothly.
Because the owner of the data
is a variable, that too, can change.
Consider declaring a variable a,
then assigning a to b (let a = “FCM”
then let b = a). You have now
transferred ownership from a to b.
But, Aber, Pero, Ale. What if you
want to keep using your original
declaration? Well, then Rust has
cloning. This allows you to keep
contents ^
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ownership of your data, but also
give ownership to another piece of
your code. If you see an error:
“value used here after move”, you
probably need to clone. By the
way, that error is really descriptive,
it tells you that you tried to use a
variable’s value after it was moved
to another owner (like in the
example above). Now cloning takes
up that same amount of memory
again, so be careful when cloning.
Don’t just clone willy-nilly. To clone
a variable, you add the “.clone” to
your variable when you use it. So
a.clone() will let you clone the
“FCM” value in our example above.
If you need to, re-read this section
in the book, I certainly did!
Now that you have an idea of
ownership, next time we can talk
about things like borrowing. As
with anything, practice makes
perfect. Try out the examples in
the book, make mistakes, learn
what the error messages mean. I
know how frustrated I was when all
I kept getting was “syntax error”
after “syntax error”. At least Rust is
a lot friendlier. Don’t be shy to try
something, the worst that can
happen is that you can die. Wait,
that is not correct? Syntax error... :)
I urge you to go through the

whole section above, right down to
part 4.4. We can delve into this
later, but for now I want you to get
to grips with why this is important
and why this sets Rust apart from
other programming languages.
Now, I don’t know Rust inside out,
nor do I know all the nuances of
programming, but as a newbie
myself, I can give some newbie
insights and things I have ﬁgured
out for myself. Remember the book
above is written for programmers,
by programmers. As a newbie to
Rust or programming, you may not
always get what they are trying to
bring across. This is where your
friendly FCM team comes in, as we
try to help you bridge that gap. If I
made any mistakes, or if you have
some insights to add that may aid
new programmers and rustafarians
alike, please drop us an email at:
misc@fullcirclemagazine.org
We welcome the feedback, as it
helps us too.

Erik has been in IT for 30+ years. He
has seen technology come and go.
From repairing washing machine
sized hard drives with multimeters
and oscilloscopes, laying cable, to
scaling 3G towers, he's done it.

full circle magazine #159
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Python In The REAL World Pt.107

Written by Greg Walters

P

yFPDF is a library that allows
you to generate PDF
documents under Python. It was
ported from FPDF ('Free'-PDF) to a
PHP library. The repository is on
github at https://github.com/
reingart/pyfpdf and the
documentation is at https://
pyfpdf.readthedocs.io/en/latest/
index.html
Some of the features that this
library provides are the ability to
include graphic images, positional
printing, lines, rectangles, ellipses,
headers and footers, and the ability
to create templated forms for
things like invoices.
It's rather old, and there hasn't
been much activity recently. In fact,
the last update to the repository
was about 3 years ago.
You can easily install it with pip
by using:
pip install fpdf

or you can clone the github
repository and install it from there
via pip like this:

pip install -e .

from the clone main folder.
Let's jump right in and create
our ﬁrst example program. Enter
this program into your favorite IDE
and save it as “ftest1.py”. We’ll
make some changes to it later on.
from fpdf import FPDF
pdf = FPDF()
pdf.add_page()
pdf.set_font('Arial', 'B',
16)
pdf.cell(40, 10, 'Hello Full
Circle Magazine!')
pdf.output('tuto1a.pdf', 'F')

Now we'll break down the
program. After we import the FPDF
library, we instantiate the library,
by calling pdf=FPDF(), with the
default options.
Next, we add a page. These are
pretty much the ﬁrst two things
that you have to do before you can
do anything else.
We then set the default font for
the page, then we use the cell
method to print some simple text,
full circle magazine #159

and then we call the output
method to create the PDF ﬁle
itself.
When we created the PDF
object, as I said, we used the
default parameters. Here's the
options:
pdf = FPDF(orientation,
units, page format) where:
orientation = (p:portrait,
l:landscape) (default =
Portrait)
units = (pt:point,
mm:millimeter, cm:centimeter,
in:inch) (default is mm)
format = (A3, A4, A5,
Letter, Legal) (default is
A4) (see below)

If you need a custom page size,
you can send a tuple with the width
and height in the given units. If you
are using Portrait mode, the order
should be (width, height), but if you
are using landscape, it should be
(height, width). Also, try as I might,
I couldn't get the units to work with
the inch option. Nothing seems to
render, so I stick with 'mm'.

Next we set the font to be used.
The call is:
fpdf.set_font(family,
style='', size = 0)

The set_font method allows you
to specify the font to be used for
the next lines of text to be
rendered. It's not quite as open as
you might think though. There are
ﬁve normal fonts you can use
which are pre-deﬁned (unless you
use "add_font" ﬁrst). These are:
• Courier (ﬁxed-width)
• Helvetica or Arial
• Times
• Symbol
• ZapfDingbats
These 5 fonts provide ﬁxed
width, sans-serif, serif, and two
symbolic fonts. The font family
parameter is case insensitive as
well as the font style. Those styles
can be:
B : bold
I : italic
U : underline
empty : regular
Note: if you want to change the
font size within the document,
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without changing the family or
style, you can call:
fpdf.set_font_size(size)

If you want to use a special font
for some reason, outside of the
standard font set provided, you can
use the add_font method.
However, it is fairly diﬃcult, so
we'll discuss it in a future article. In
the meantime, you can look at the
documentation to see how to do it.
Now, we'll take a look at the cell
method, that allows you to place
the text to be rendered. This
method will print a rectangular
area with optional borders,
possibly background and
foreground colors, and the
character string. The text can be
aligned to the right or left or can
be centered. When the call is
ﬁnished, the current position
moves to the right or to the next
line, depending on a parameter
passed, and allows for an optional
link to be attached to the text. The
format of the method parameters
is fairly comprehensive, but, luckily,
the author of the library has set a
number of defaults, so it isn't as
bad as it could be.

fpdf.cell(w, h=0, txt='',
border=0, ln=0, align='',
fill=false, link='')

We'll take a look at each
parameter in a bit more depth...
w: Cell width. If this value is 0, the
cell will extend to the right margin.
h: The cell height. Default is 0.
txt: string to print
border: 0: no border, 1 : frame (or a
string containing which lines of the
frame to be rendered)
ln : 0: to the right, 1 to the
beginning of the next line, 2: below
align: 'L' left align, 'C': Center, 'R' :
Right align

Once the program is done, you
can open it with your default PDF
viewer. It should look something
like the image above.
Now, we will take a look at
adding the link parameter to the
call method. Change the last two
lines of your test program to:
pdf.cell(0, 10, 'Hello Full
Circle Magazine!',
1,1,'C',0,"http://
fullcirclemagazine.org")

ﬁll: True: Background painted,
False: Transparent. Default = False

pdf.output('test1a.pdf', 'F')

link: URL or identiﬁer returned by
add_link()

Notice that we added all the
parameters for the cell method. In
this version, we will be adding a

border with transparent ﬁll, make
the text centered, have the cell go
from the far left extending to the
far right of the page, set the next
text line to be on the line below,
and added a link to the Full Circle
Magazine website, when you click
on the text. We also changed the
output ﬁle name.
Save the program as “test1a”
and try it again (see image below).
That’s great, but what if we
want to do full paragraphs of text?
There is a method that is close to
the cell method that will handle
this for us. It’s called multi_cell. The
multi_cell method uses the
following parameters:

Finally, we call pdf.output to
render the ﬁle and save it as the
ﬁlename speciﬁed (which is the ‘F’
parameter). There are other
parameters that you can research
in the document.
full circle magazine #159
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pdf.multi_cell(w: float, h:
float, txt: str, border = 0,
align: str = 'J', fill:
bool = False)

It can be used in place of the
cell method, but we are going to
do something special to
demonstrate this. This time, we will
extend and override some of the
builtin functions (that are simply
stubs that are designed to be
implemented in your code) which
are header and footer, and add a
couple of our own. Open another
blank ﬁle in your IDE and name the
ﬁle Demo3.py.
from fpdf import FPDF
import sys
import os

Of course, we have to start oﬀ
with the import statements. Next,
we’ll extend the fpdf class by
creating a header and footer
method for ourselves (borrowed
from one of the demos in the
documentation). See top right.
The header method, as you
might guess, creates a header that
is (mostly) centered horizontally
and consists of the title of our

document. First, we set the font,
then we use the get_string_width()
method to calculate the width in
whatever unit value that was set
for the title when it would be
rendered. That is then placed in a
cell starting at the proper place at
the top of the page. You could use
a “0” in the cell method in place of
the “w” and not use the set_x
method, forcing the cell to start at
a x position of 0 and extending to
the right margin, but you really
should see this alternate method.

class PDF(FPDF):
def header(self):
self.set_font('Arial', 'B', 15)
# Calculate width of title and position
w = self.get_string_width(title) + 6
self.set_x((210 - w) / 2)
# Title
self.cell(w, 9, title, 0, 1, 'C', 0)
# Line break
self.ln(10)

def footer(self):
# Position at 1.5 cm from bottom
self.set_y(-15)
self.set_font('Arial', 'I', 8)
# Text color in gray
# self.set_text_color(128)
# Page number
self.cell(0, 10, 'Page ' + str(self.page_no()), 0, 0, 'C')

The footer method handles
placing the page number at the
very bottom of the page, in this
case (middle right) 15 mm from the
bottom. You can set the color of
the font, but I commented it out.

diﬀerent types of paragraphs. This,
(below) again, was mostly
borrowed from the
documentation:

optional, but we’ll do it here, just
to show you how to do if you ever
want to (these are outside of the
class, so they are not indented):

Next, we’ll create a method to
handle multi-line text. You can
create diﬀerent methods to handle

Now, we’ll set some normal
variables and add some properties
to the PDF ﬁle. The properties are

Now, we send each group of
text into the chapter_body()
method we just created. For the

def chapter_body(self, name, fontfamily=None, fontattrib=None, fontsize=None):
# Read text file
with open(name, 'rb') as fh:
txt = fh.read().decode('latin-1')
if fontfamily == None:
# Times 12
self.set_font('Times', '', 12)
else:
self.set_font(fontfamily, fontattrib, fontsize)
# Output justified text
self.multi_cell(0, 5, txt)
# Line break
self.ln()

full circle magazine #159
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demo, I chose some text from last
month’s article and one of the
programs to try to demonstrate
how to use diﬀerent font settings
(top right).
pdf.chapter_body('demotext1.t
xt')
pdf.chapter_body('demotext2.t
xt','Arial','B',14)
pdf.chapter_body('birthdays2.
py','Courier','B',11)

Now we render and save the
PDF ﬁle:
pdf.output('demo3.pdf', 'F')

Finally, the following code
(again borrowed from the
documentation) will open the
system default PDF viewer,
assuming one is set, to display the
PDF we just created. This saves you
and the user the need to open a
ﬁle manager window, dig around
for the ﬁle and open it that way. I
know the code works for Linux, but
haven’t tried it on a Windows
machine or a Mac.

title = 'Demo3 for Full Circle Magazine'
pdf = PDF('p', 'mm', 'letter')
pdf.alias_nb_pages()
pdf.set_title(title)
# Properties start here...
pdf.set_author('G.D. Walters')
pdf.set_subject('Demonstration program for Full Circle Magazine Issue #159')
pdf.set_keywords("PDF, Demonstration, Full Circle Magazine")
pdf.set_creator("Python")
# Properties end here...
pdf.add_page()
else:
os.system("./demo3.pdf")

Now that the PDF is (hopefully)
visible, check the properties of the
document, after you check the text
in the PDF itself. You should see
something like this:

So there you have it. The
beginnings of the ability to create
your own PDF ﬁles. I strongly
suggest that you download the
repository with all the source code.
It gives you a great insight into the
abilities of the library. The biggest

thing we didn’t talk about this time
is the ability of the library to use
pre-deﬁned templates. We’ll save
that for the next article.
The code ﬁles (and the text ﬁles
for the last demo) have been
uploaded to pastebin to make life
easy for you. The links are below:
test1.py - https://pastebin.com/
L2vUhAfa

demotext2.txt - https://
pastebin.com/6AkCvMxx
birthdays2.py - https://
pastebin.com/0Gwke6FD
Until next time; stay safe,
healthy, positive and creative!

test1a.py - https://pastebin.com/
WsrGVPPU
demo3.py - https://pastebin.com/
jaXSAJKg

if
sys.platform.startswith("linu
x"):
os.system("xdg-open ./
demo3.pdf")
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demotext1.txt - https://
pastebin.com/6FiWk7HF
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Greg Walters is a retired
programmer living in Central Texas,
USA. He has been a programmer
since 1972 and in his spare time, he is
an author, amateur photographer,
luthier, fair musician and a pretty
darn good cook. He still is the owner
of RainyDaySolutions a consulting
company and he spends most of his
time writing articles for FCM and
tutorials. His website is
www.thedesignatedgeek.xyz .
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Written by Tony Hughes

I

know this is probably something
everyone already knows, but, for
clarity, and for the occasional
reader who has never heard of a
podcast, for the purpose of this
article a podcast is a piece of Audio
that has been released via the
internet for listening to on an
audio device at a time of the
listener’s choosing. This can be a
professional program that also
aired on the radio, or a piece of
audio content that is created by
someone who wants to reach an
audience for whatever reason.
Many people now make a living
through creation of audio
podcasts, in the same way as
YouTube content creators. There
are many podcasts out there to
meet the needs of the diﬀerent
interests of people, such as
technology, health and ﬁtness,
food and ﬁlm fandom to name a
few. There are also many podcasts
out there relating to Linux, and Full
Circle Magazine has a weekly news
podcast informing the listener of
the latest Linux News.

MY STORY

Podcast Production in Linux - Pt.1
Before we start, just a little
information about me and my
podcasting journey. I started using
Linux around 2006/7 when I started
to refurbish old PC hardware (at
that time Pentium 2/3 PCs. These
were often made from donated
PCs and parts given to me on
Freecycle (now Freegle here in the
UK). As many of the
PC’s did not have a
valid Windows
license, Linux was
the only viable and
legal option for
these PCs.
This was shortly
after Ubuntu had
become an easier
route into Linux,
not perfect as you
still needed a little
bit of knowledge to
get all your audio and video,
including DVD movies, to play, but
way easier than it had been prior to
Canonical starting Ubuntu. So I
started to use Xubuntu as the OS
on these low-spec machines. Often
they would have the bare minimum
of 196MB of Ram that Xubuntu
full circle magazine #159

needed, and it would have been
impossible to install Windows XP
SP2 as it would not have run
anyway. However Xubuntu, while
not lightning fast, still worked
quite well on these systems. As a
result of using Xubuntu on these
machines, I started to use Ubuntu
as a dual-boot with Windows XP on
my then Pentium 4 2.5 GHz tower
PC, with 2GB Ram and a 40GB HDD.
A couple of years later, in
2009, I chose to
only use Ubuntu
after a PC
meltdown
requiring a total
reinstall, and I have
been a full-time
Linux user since
that time. Since
2011, I have been
predominantly a
Mint Mate user,
although, as you will hear, I am a bit
of a distro-hopper.
My ﬁrst proper podcast was
actually the Full Circle podcast,
when it was still a full podcast and
not a news show as it is now. For a
few months, Les Pounder, John
Chamberlain, Oliver Clark from
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Blackpool LUG, and myself, took
over from the previous host, but,
unfortunately, we suﬀered from
pod-fade as, at that time, we were
all in full time employment and had
underestimated the amount of
work involved in recording and
editing a regular show. However,
we had some fun, and it ignited a
spark that has been rekindled in
the last 3 years, ﬁrst as a Hacker
Public Radio (HPR) Host, and, since
last October, one of the regular
hosts of mintCast, which led to the
creation of the Distrohoppers
Digest podcast with one of my
fellow hosts of mintCast.
So the idea for this short series
will be to share some of what I’ve
learned over the last few years
about podcasting, and how, YOU,
the reader, could go about having a
go for yourself. So let’s start.

REQUIRED HARDWARE
First, let us look at the hardware
you need to record and edit your
audio. If you want to record for
Hacker Public Radio (HPR), they are
more concerned on getting content
contents ^
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and new hosts, so, as long as your
audio is legible, then you are OK.
For more regular podcasting, the
better your audio the more likely
you are to build a regular audience,
so I will be taking you through the
steps to get fairly decent audio
quality during this series, but ﬁrst
let's look at the basics.
If you just want to record the
occasional short piece of audio,
modern smartphones these days
can record reasonable quality
audio. You may have seen pictures
of journalists chasing people in the
streets, pushing their phone at
them to get a quote, so if it’s a
good enough option for a
professional, it may be suﬃcient
for occasional recording to get you
started. If you have a phone with
an audio jack, you can buy fairly
good microphone and headphone
sets that will record directly onto
your phone. Also if you want to use
your phone to record interviews
with others, there are standalone
microphones available that will do
this. A little research on the web
will ﬁnd a number of options
ranging in price from around £10
upwards, but it’s always good to
read reviews of what is the best
option in your price range. Also
there are a number of apps that

you can install from the relevant
app store that will record your
audio onto the phone, but more of
that when we look at software. You
can also buy small portable
recorders that are combination
microphones and recording devices
and these can be used as portable
recording devices or connected to
a PC as an audio input device.
Zoom recorders are one device
that many in the podcast world
use, and earlier models can be
picked up quite reasonably. I
personally have the H2, and a
number of my HPR interview
episodes have been recorded with
this over the years. If recording
using a desktop or laptop PC and
audio quality is more important to
you, you may wish to invest in a
more professional microphone
with a boom arm, pop ﬁlter, and
vibration damper, and a hardware
mixing desk, but more of that later
in the series.

mixing long multi track audio, an i3
PC with 4-8GB Ram should be
adequate for basic recording and
editing.
So now you know what
hardware you need to get started.
In the next article in this series we
will look at the software you will
need to use for both recording and
editing any audio you have,
however you recorded it.
TonyH1212@DigestDistro
http://hackerpublicradio.org/
correspondents.php?hostid=338
th@mintcast.org
distrohoppersdigest@gmail.com
https://
distrohoppersdigest.blogspot.com
https://mintcast.org/
http://hackerpublicradio.org

For static recording and later
editing of that or other audio, a
basic laptop/desktop PC with Linux
Mint (or your distribution of
choice) will be suﬃcient; you can
also get software for basic editing
on a phone or tablet, but, as I’ve
never used that option, I can not
really say how eﬀective it is. For
full circle magazine #159
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Rawtherapee - Pt5

Written by Erik

I

f you have been following along
in our little tutorial series,
welcome back. This time around,
we have a very random photo. It is
bland, but the lines are more or
less straight. Mmm... think we can
do something with this?
This is going to be a rather
short / quick tutorial, as I want you
to notice how quickly one can work
inside Rawtherapee. You do not
have to spend hours getting
something like wallpaper for your
new wide monitor, it should be
quick. (I would just like to point out
that I do not have a new wide

monitor, but my friend does, and he
was bemoaning the lack of original
wide wallpapers.)
How about we hit the road
running as you guys know your way
around Rawtherapee already?
Under our exposure tab, let’s add
some saturation, until the sky
actually becomes a better blue. I
will increase it by ten (10).
Immediately we have more life or
realism, if you like. Ten, may even
be a bit much, but it is not set in
stone and you are welcome to use
less. (But - there is a method to the
madness.) The idea here is just to
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teach you that washed out photos
are not lost. Though the old ten ton
crane is not the focus of the
picture, I want to draw the eye to
it.
Turn on your HSV equalizer.
Bonus points if you knew where it
was immediately. Again, we will
head to saturation and open its
equaliser. I want to create a sine
wave between red and yellow, with
yellow high and red low. Once I
have my sine wave , I want to move
the red vertical bar into the orange
spectrum, to remove some of the
red. That done, we open the
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equalizer for the value and remove
all the points except yellow and
red. By now you should know that
to remove a point, you simply drag
it outside of the box. I will minimize
and maximize red an yellow and
move the red into orange again,
making that gaudy yellow more
natural.
towards green, until the yellow in
the picture fades out. (So those of
you who want to get freaky, this is
where you get freaky.) Just realise,
here is your chance to focus the
attention by simply manipulating
one colour and muting the rest.
I would like to reiterate that the
interpretation of your photo is up

to you. Do what makes you happy.
If you follow our guides, you will
know where to do that.

I hope you learned something,
and if you have any comments or
queries, direct them to
misc@fullcirclemagazine.org.

So now if I turn this picture on
its head, crop it and export it, I
have another nice wide
wallpaper. :) The possibilities are
limited by your imagination!

So now lets see what we can do
about the rust? Head into hue and
open that equaliser. The
adjustments here are a lot more
sensitive than the other two
values. Zoom in to a section
containing the rust. I am going to
bump magenta and yellow up and
dip red slightly, again moving it
towards orange, but only slightly. If
you want an artistic photo, this is
your chance, just move yellow

Erik has been in IT for 30+ years. He
has seen technology come and go.
From repairing washing machine
sized hard drives with multimeters
and oscilloscopes, laying cable, to
scaling 3G towers, he's done it.
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Inkscape - Part 99

Written by Mark Crutch

T

his month I’ll be continuing to
look at the new view features
in Inkscape v1.0, beginning with an
addition to the View > Display
Mode menu. If you’re a long-time
reader of this column, then not
only do you deserve some kind of
award (perhaps an Inkscape-drawn
certiﬁcate), but you’ll also be
familiar with the “Outline” display
mode.
Known informally as the
“where’s my invisible stuﬀ” mode,
this feature renders every element
as a simple outline, regardless of
its usual ﬁll and stroke settings. It’s
invaluable for those times when
you’ve created an otherwise
invisible object – whether by
accident or intent (there are some
good reasons why you might want
to). Typically, this is an early
mistake by new users who
inadvertently clear both the ﬁll and
stroke, make the colors
transparent, reduce the opacity on
the whole object, or go a bit crazy
with the blur slider. In these cases,
View > Display Mode > Outline lets
you see, and select, your invisible
object, whether to delete it or try

to wrangle it back into a visible
state.
The new view mode is related,
but diﬀerent. Whereas Outline
mode renders everything as
outlines, losing patterns, ﬁlls and
strokes in the process, the new
“Visible Hairlines” feature just
makes really thin strokes a bit
thicker, but otherwise displays
most other objects and properties
the same as usual. An example will
probably help to explain, so take a
look at these ﬁve stars:

“Five stars?” you say. “But I can
only see two. Maybe three or four
if I zoom right in and squint a bit.”
There are, indeed, ﬁve stars.
None of them are hidden. None
have any transparency or reduced
full circle magazine #159

opacity applied. None are ﬁltered.
Yet some are deﬁnitely easier to
see than others – and one is not
visible at all. What’s going on here?
Perhaps if I describe each star you
might realise what’s happening:
Top left: 1px black stroke.
Top right: 64px black stroke.
Bottom left: 64px light gray stroke.
Bottom middle: 0.1px black stroke.
Bottom right: Red ﬁll.
The visible stars on the right are
easy enough to explain – one has a
thick stroke, one has a ﬁll. The
bottom left also has a thick stroke,
but in a light color that makes it
hard to see. The top left is possibly
just about visible: these are large
stars, and the page is zoomed out,
so that a 1px stroke is just on the
edge of Inkscape’s display
capabilities. If you go much thinner
– as I have done with the 0.1px
stroke on the remaining star –
Inkscape just doesn’t render it at
all.
Let’s see how these look in
Outline mode.

27

Here we see the problem with
Outline view. Yes, we can now see
all the stars, which is great for
ﬁnding invisible objects. But they
all look the same, regardless of
their original styles.
Compare this with View >
Display Mode > Visible Hairlines:

Although it may not be clear in
the magazine, the top left star is
ever so slightly thicker. Our
previously invisible star is also
rendered with the same thickness.
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The two stars on the right just
appear as they usually would – as
does the star at the bottom left,
which is still diﬃcult to see.
This view mode is intended to
help if you are designing an image
for use with a laser cutter or similar
device. These machines often
require paths to have a purely
nominal thickness – 0.1mm is a
typical value – which can easily
result in them disappearing from
view when you zoom out. By
switching to Visible Hairlines mode,
you ensure that Inkscape will
always display strokes at a
thickness that is enough to keep
them visible. It doesn’t change the
actual widths in the SVG ﬁle, so
your laser cutter won’t complain,
but does mean that objects no
longer vanish while you work.
Any stroke that is already above
the minimal limit will be rendered
as usual. That’s why the thicker
strokes on the top right and
bottom left stars are unaﬀected.
As you can see with the bottom
left, however, that can still lead to
barely visible shapes, so Outline
view still has its place. As the
bottom right star shows, ﬁlls and
other properties are also rendered
as normal in this view. Filters don’t

fare very well, but as they are
purely visual eﬀects that don’t
alter the geometric information
that a laser cutter might use,
they’re not generally used in the
sort of situations that this mode is
intended to address.

I created the smallest one ﬁrst, and
set its opacity to 25%. Then I
duplicated it and resized to create
the second one; then duplicated
and resized the second to make the
third; same for the third to the
fourth.

Most users won’t need this
mode. If you just want to ﬁnd an
invisible object, Outline mode is
still your best bet. But if you do
have to work with exceptionally
thin strokes, and ﬁnd they vanish
when you zoom out, this mode is
just the thing for you.
If you are on the hunt for
invisible objects, or those hidden
behind other items, there are a
couple of other new features
hanging around on the View menu:
View > Split View Mode and View >
XRay Mode. They’re a little like
dynamic versions of the Outline
view mode, giving you the best of
both worlds – both outline and full
display, at the same time. They
should also both be on the Display
Mode submenu, in my opinion, but
probably live on the main menu to
make them more discoverable.
Let’s look at Split View Mode ﬁrst.
This image is made up of four
stars, identical except for their size.
full circle magazine #159

My question to you is this:
what’s the easiest way to select the
smallest star? Due to the order in
which I created them, it’s at the
bottom of the z-stack, so a simple
click won’t do the job. Here are
some methods that would work in
this particular case:
• Careful rubber band selection.
• Hold Alt (or Super-Alt on most
Linux boxes) and repeatedly click in
the same spot to select below the
current object.
• Reorder the stack manually
before selecting.
• Reorder the stack using
Extensions > Arrange > Restack
before selecting.
• Switch to Outline view mode,
then select.
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The last option is arguably the
most practical. It doesn’t require
you to change the arrangement of
items in your drawing, and is
probably less likely than the others
to result in the wrong thing being
selected. But it’s a pain to turn
Outline mode on and oﬀ via the
menu, and you may not use it often
enough to warrant learning more
keyboard shortcuts.
What would be really handy is a
way to get a temporary outline
view of the drawing, but then
switch back to normal view simply
and intuitively. With Split View
Mode that’s almost what we’ve
got. Almost.
You can activate the new mode,
via the View > Split View Mode
menu. The default keyboard
shortcut is Ctrl-6, but this is 6 on
the main keyboard, not the
numeric keypad. I ﬁnd this a little
odd, given that the default
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shortcut for cycling through the
display modes uses Ctrl with 5 on
the numeric keypad. However you
trigger it, enabling this mode will
immediately split the workspace in
two, with the left side showing the
normal view of your document, and
the right side showing the outline
view.

complex documents. Just enable
Split View Mode then slide the
splitter to one side to give you a
normal view most of the time,
swinging it back into play for tricky
selections, before swiping it away
to the side again, ready for
redeployment in an instant. Except
it doesn’t work like that.

A large circular handle at the
middle of the screen can be
dragged to move the split point,
allowing more or less of the view
to be displayed in outline mode.
Four triangles within the control let
you switch the orientation of the
split between horizontal and
vertical, and determine which side
of the split should show the outline
view. Both sides of the display
work as normal, so you are free to
select items in the outline view
then manipulate them in the
normal view, or vice versa. Clicks
and drags on the splitter control
are not propagated through to the
objects below so you can, for
example, make a selection in
outline view then adjust the split to
give you more of a normal view
without the objects becoming
deselected as you do so.

If you drag the handle too close
to the edge of the workspace, this
mode gets deactivated, requiring
another trip to the View menu, or
hitting the keyboard shortcut, to
switch it on again. But there’s no
visual indication of where “too
close” begins. And it’s deactivated
even if you’re still in the process of
dragging, without the courtesy of
at least waiting for you to release
the mouse button! The result is
that it’s too tricky to leave this
mode enabled at all times, just
swiping the splitter in and out of
view as needed, because you’re
bound to swipe it too far at some
point and turn the feature oﬀ.

On the surface, this looks like a
great addition for working with

down to get it out of the way of
your content. But even though
you’re not moving the splitter
itself, drag it a pixel too high or low
and the whole mode turns oﬀ,
requiring you to start at the menu
again.
This mode also doesn’t store the
split state between invocations.
Every time you enable it you’ll be
put directly into the same 50/50
view with the outline on the right.
It doesn’t matter if you previously
switched to 70/30 with the outline
at the bottom, or any other
combination. Once this mode is
turned oﬀ, and then back on again,

it drops you straight to the default.
And given how easy it is to
accidentally turn it oﬀ, it makes
working with this mode more of a
pain than a pleasure. It does make
for nice screenshots when
demonstrating the density of
objects in a complex drawing
though.
View > Xray Mode is a closely
related, but slightly diﬀerent
feature. The keyboard shortcut for
this is Alt-6, by default, but once
again this has to be the 6 on the
top row of keys, not on the numeric
keypad. Switching this on enables
outline view in a circle immediately

Worse still, moving the big
handle towards any edge has the
same eﬀect, regardless of the
splitter orientation. With a vertical
splitter, separating the two halves
to the left and right, you might be
tempted to move the handle up or
full circle magazine #159
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surrounding the mouse pointer.
Like an X-ray, it cuts through the
body of your drawing to show you
the bones that support it. But it’s
more like a tightly controlled “X-ray
beam” from a pulp comic book than
the large format plates that are
routinely hung from wall-mounted
light boxes in medical dramas.
As with Split View Mode, you
can still make selections and
perform other tasks with this mode
activated. There’s no way to
change the size or shape of the
beam, and no way to ‘leave it’ at a
particular place while you use the
mouse elsewhere. To my mind this
mode is a fun distraction, but
ultimately not very useful for dayto-day work.

useless 3D box tool. I have, of
course, ﬁled a feature request for
this – as well as one for
improvements to the Split View
mode.
That’s it for the new view
features in v1.0. Next month will be
the 100th article in this series, so I’ll
be celebrating this milestone by…
continuing to bring you details of
some of the other new features in
the latest Inkscape release.

If you struggle to select objects
in busy drawings, then it might be
worth changing the keyboard
shortcut to make it easier to toggle
on and oﬀ. What would be nice is a
‘hold-to-activate’ key, like the ‘Q’
key for the quick-zoom function,
which would allow you to press and
hold a key for long enough to make
a tricky selection, but would return
you to the normal view as soon as
you release it. It would certainly
make for a better use of the ‘X’ key
than as a shortcut for the largely

Mark uses Inkscape to create three
webcomics, 'The Greys', 'Monsters,
Inked' and 'Elvie', which can all be
found at http://
www.peppertop.com/
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Written by Alan Ward

T

his series is aimed at learning to
make something of the old
photos in my possession, and
others in the public domain due to
their age. You, the reader, are
welcome to tag along and I hope
glean some small insight and
perhaps an idea or two from time
to time. No promises are made as
to quality of the content, or
potential errors and omissions. I
am a computer scientist, not a true
artist or a professional of image
restoration. So please take all this
as a best eﬀort, but with no ﬁrm
guarantees — much as is the case
of most open-source software.
In the previous part of this
series, we focused on clearing up
dark splotches and other defects
on a photo that had been taken
using 35mm photographic ﬁlm,
then scanned using a ﬂatbed
scanner and then converted to a
positive. As announced at the end
of Part 8, we will ﬁnish this series
by taking a look at old photos
taken using the digital cameras
that became mainstream. Not all
were created equal, and some of
the earliest had sensors that lacked

Krita To Rework Old Photos Pt.9
the quality we are used to seeing
today in modern equipment. In
four successive parts, we will tackle
some speciﬁc defects of early lightsensitive chips: lack of sensibility,
which is a drawback when shooting
dark scenes; lack of contrast; lack
of resolution; and ﬁnally lack of
color dynamic range. Taken
together, these weak points tend
to give early digital photos a
lackluster, washed-out and blurry
feeling in contrast with those made
using even rather common mobile
phones today.
To begin with, let us take a look
at an interior photo I took in Trinity
College, Dublin, in year 2006. It
posed two typical challenges to
previous generation digital chips:
on the one hand, the lighter parts
where direct sun comes in through
the ceiling and washed out, to the
point that some of the joints look
thinner than they really are, and on
the other the lower half of the
image has registered very little
light at all. The chip inside the
camera simply could not cope with
such a huge variety of lighting
levels in a single scene.
full circle magazine #159
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Our aim will be to maintain
whatever quality is available in the
upper half of the image, while
enhancing the darker half to pick
out as much detail as is hidden
among the shadows. A simple
strategy would be to use color
curves as discussed in part 3 of this
series, to correct this imbalance.
So, we are oﬀ to menu option
Filter, then Adjust and “Color
Adjustment curves”. We raise the
lower (dark) part of the curve,
while maintaining the upper half
on the diagonal line to retain the
original response. With just three
control points adjusting the lower
half of the curve, the darker part of
the image clears up nicely, and we
can now see some action at the
end of the corridor.

around a drab gray. This is
especially visible in the
woodworking around the windows
in the ﬁrst ﬂoor, which has a
completely washed out look.
Basically, this is the result of a
section of the adjustment curve
that has a very ﬂat slope, which can
be seen on the curve between the
second and third adjustment
points. A ﬂat slope means that
similar colors will be drawn
together, and contrast is lost.
So, applying a color adjustment
curve directly does not seem to be
a good solution. A more advanced
technique consists of two stages. In
the ﬁrst, we shall decompose the
image into three separate

channels. The ﬁrst, known as Hue
(H), gives us the actual color of
each pixel, as deﬁned along the
chromatic circle. We can think of
hue as deﬁning whether we are
speaking of a red, or are more close
to a green, or perhaps our pixel has
a tinge of yellow. The second
channel, Saturation (S) represents
the force of the color. A gray is a
color with low or extremely low
saturation; as saturation increases,
colors will have more character and
seem vibrant. ﬁnally, Value (V) tells
us whether the pixel is a dark, or a
light color. Contrary to other image
manipulation programs such as
GIMP, in Krita one does not easily
perform HSV channel separation
decomposing a layer into its

diﬀerent components in separate
images. But the color adjustment
curve can be used to tweak a single
channel. Select “Color adjustment
curves” once more, but this time
choose channel “Lightness” (this
being the Krita term for Value)
instead of RGBA (see next page,
bottom left). We can now push up
the lightness of the lower portion
of the image, without altering color
balance.
The ﬁrst ﬂoor woodwork now
looks like natural wood, not gray
paint. The dark red at the end of
the lower hall section is now a
more natural color than in our
previous try.
We can go a bit further with this
tool. Suppose we now wish to
increase saturation, raising color
intensity slightly in the lower half
of our image. We could go, once
more, into “Color adjustment
curves” and select channel
“Saturation” using the appropriate
curve. But doing this would
increase saturation all over the
board, for all parts of our image.
What we actually need to do is
increase saturation, but only for
the darker colors. For this reason,
the tool we will use is in menu
option Filter, then Adjust and

More color is now to be seen.
However, the lower half of the
image is still not perfect, there are
several darker shadows and the
end result is quite dark and has less
detail than one would like.
Luminosity could, in theory, be
increased yet more by giving the
color adjustment curve an even
steeper incline at the extreme left.
This, however, can give weird
eﬀects to lower-to-mid tone colors,
which tend to group together
full circle magazine #159
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option “Cross-channel adjustment
curves”. In this, we can specify we
wish to adjust Saturation, but
making our adjustment dependent
on another channel. This is called
the “driver channel”, which in this
case is “Lightness”. So, choose this
curve and increase saturation for
lower values of lightness – this is
the left half of the curve.
The lower part of the corridor
now has slightly more vibrant
colors, though remaining quite
realistic. The woodwork on the ﬁrst
ﬂoor also has a tad more character
than in either of the previous
images.

and showcase some of Krita’s
excellent range of options to
rework our original photos that are
slightly oﬀ. With some practice, we
can often go quite a bit further in
restoring old and dark photos,
beyond increasing the whole
image’s luminosity. However, in
other cases old digital photos can
have quite the opposite defect,
coming out too clear and with
colors washed out by too much
light in the original scene for the
camera’s chip. We will work on this
scenario in the next part of our
series. Until then, take care!

Alan holds a PhD. He teaches comp
sci and eng at Escola Andorrana de
Batxillerat. He has given GNU/Linux
courses at the Uni of Andorra and
taught GNU/Linux systems admin at
the OU of Catalunya.

These tools are quite advanced,
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LINUX LOOPBACK

OpenZFS

Written by S. J. Webb

O

ne of the hallmarks from BSD
is the ZFS ﬁle system. It stands
for Zettabyte File System. It was
developed for use in openSolaris
under the Sun Microsystem banner.
The main authors are Matthew
Aherns and Jeﬀ Bonwick. Oracle
purchased Sun, consequently
openSolaris became close sourced.
In retaliation, the ZFS developers
left, and created the OpenZFS
Foundation.
The foundation’s sole purpose
was to further develop ZFS for
diﬀerent operating systems. It was

quickly adopted by the BSD world.
However, it is slow in Linux distros
for ﬁle system adoption. The
original license is prohibitive and is
not compatible with most Linux
licenses. As I understand it, the
original license requires all old ZFS
contributors to sign on to the
license change. Unfortunately a
few of the ZFS coders are missing
or deceased. Therefore it is
diﬃcult to have a successful license
switch to a Linux compliant license
for the kernel.
Yet developers will supply the

means to install OpenZFS into the
distro. According to the OpenZFS
sources, these operating systems
can utilize it.
Since Ubuntu 19.10, ZFS is
installed as root as an option
during installation. Further details
can be found here regarding ZFS
and Ubuntu. I recently installed
Ubuntu MATE choosing the ZFS
option.
I had no issues using the ZFSfused Ubuntu MATE on my laptop. I
use this laptop with the
experimental code with zero issues.
However, I am not a power user, so
my use case is fairly weak. I am
currently using it for writing, web
surﬁng, and the occasional Zoom
conference. Yet why consider using
ZFS on Linux?
As taken from the FreeBSD
manual, these are the three aims of
ZFS: data integrity, pooled storage,
and performance. Data integrity
focuses on the ability of checking
the data against a checksum; ZFS
takes snapshots of the system. If
there is no match against the
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checksum, ZFS will attempt to
correct the errors. Pooled storage
is the ability to increase memory
when devices are added into the
system for all the ﬁle systems. In a
large data storage system, these
features would be desired. I have
no experience in data management
ﬁle systems. The performance is
desirable, but a central caveat is
that ZFS can be expensive to
maintain and implement. The
system requires extra drives.
Therefore it is a bit more
expensive.
Next month I will take a look at
the Software in the Public Interest
non-proﬁt corporation. It is a nonproﬁt organization based in New
York that focuses on open source
hardware and software.

SJ Webb is a researcher coordinator.
When he is not working, he enjoys
time with his wife and kids. He
thanks Mike Ferarri for his
mentorship.

contents ^

EVERYDAY UBUNTU

Written by Richard Adams

Richard 'Flash' Adams spent about
20 years in corporate IT. He lives in
rural northwest Georgia, USA, with
his adopted 'son', a cockatiel named
Baby.

full circle magazine #159

36

contents ^

UBPORTS DEVICES

Written by UBports Team
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MY OPINION

Written by Knightwise

E

veryone likes a piece of Pie.
Preferably hot apple pie with a
slice of whipped cream or vanilla
custard served on a hot day.
However, that is not the Pie I am
talking about. I'm gibbering about
everybody’s favorite Single Board
computer that costs nothing, and
can do more tricks than a hamster
on cocaine: The Raspberry Pi.
Should you have just returned from
an interplanetary voyage that has
cut you oﬀ from earth
communications over the last 5
years, I'll quickly recapitulate. The
Raspberry Pi is a tiny and supercheap line of "single board
computers" that run Linux. Lately,
the fourth iteration of the Pi came
out (each board even more
powerful than its predecessor)
heralding that it "could even be
used as a desktop computer". But
what if you already HAVE a desktop
computer, and what if you aren't
really good at soldering, and
breadboards, and not able to
program a pi-powered-orangejuice-machine if your life depended
on them. Would it still be useful? I
handed over 40 bucks and found
out for you guys.

SO WHY GET A PI?
One thing I like about the
Raspberry Pi is that they are small,
simple and single purpose devices
that consume hardly any power.
They don't take up a lot of room,
they don't have noisy fans, and my
better half doesn't complain about
'yet another computer' that I'm
dragging into the house. I love to
experiment with Linux and this has
led to me "adopting" a couple of
broken-down laptops with busted
screens from friends and family,
and turning them into headless
linux servers for a variety of
purposes. It's a fun way to
"experiment" but not very
practical. A Raspberry Pi proved to
be a very interesting alternative so
I have been giving it a go.

WHAT DO I USE MY PI FOR?
Let me just say: I'm not a
programmer, and can't solder 2
wires together at gunpoint. So
building a brain for the next ﬁnalist
of "Robot Wars" was out of the
full circle magazine #159
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question. I've tinkered with the
Raspberry PI 3 as a 'desktop
replacement', but found it wanting.
Sure: A 40 euro computer makes
for a pretty cheap desktop, just like
a 14-year-old second-hand Lada
makes for a great ﬁrst car: both of
them are cheap, but leave you
wanting something more. A Pi for
me is an appliance. Something
cheap and simple you use to do
one thing and do it well (like an
electric toothbrush). An appliance
for me is easy to set up and low in
maintenance. So, when picking a
distro (there are plenty of them
out there), I settled on Dietpi; a
great distro that lets you turn a
single-purpose device into a multipurpose Linux server without
having to break the bank OR get a
degree in coding.

When you are done with that the
fun starts. Using the commands
‘dietpi-conﬁg’ and ‘dietpi-launcher’,
you can tune and tweak your Pi to
your heart's delight. The interactive
ncurses menu lets you change
diﬀerent conﬁguration options
that would otherwise take you
weeks of digging around in the
terminal. From a massive list of
apps, you can select which
functions you want your Pi to do.
Stuﬀ like Plex - an open VPN
server, a surveillance station to a
NAS drive, or even a BlockChain
Bank – all get installed
automatically using scripts that
actually work.

HOW DOES DIETPI WORK?

I could write a small book on the
diﬀerent kinds of software and
services you can install with the
"one click" menu. But I will let you
ﬁnd that out for yourself. The guys
(and girls) behind the Dietpi project
have written a comprehensive list
of all the tools included, describing
what they do, how to get them
started, and, of course, provide the

After installing Dietpi, if you can
call copying the distro to your
MicroSD card ‘installing’, you run
through a command-line wizard
that helps you set up the right IP
address for your server, and reset
the standard login and password.
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link to the original project. You can
peruse the list at your heart's
content, and add and remove
whatever apps and services you
want – thanks to the automated
scripts from the menu. I'll give you
a small rundown of what I use my
Dietpi for.

OPENVPN SERVER
I'm out and about a lot, and use
quite a few guest wiﬁ-networks at
clients or when I travel. I consider
these networks "Hostile". For the
sake of privacy and security, I
prefer to encrypt my traﬃc in a
VPN. By turning my Raspberry Pi
into an Open Vpn endpoint, I can
do just that. I can encrypt my
traﬃc (there are open VPN clients
on all platforms), have a direct
connection with my home network,
AND I don't have to fork out extra
cash for an external VPN Service.
Don't worry if you don't have a
static IP at home. Dietpi even has
built in apps in the list that keep
your changing IP linked to a ﬁxed
DNS name.

PIHOLE
I love ads! I love clicking on
them and buying stuﬀ from them. I

adore how cookies track my every
move, and how the Facebook Pixel
is slowly starting to know me
better than my own therapist.
Sometimes, I just stare at websites
for hours, just waiting for a popup
to appear that I can click on. But
seriously... of course not. That is
why I run the Pihole server on my
Dietpi. This customized DNS server
takes care of ﬁltering out all the ad
riddled domains, and gives you a
lot more control over the ads that
you see on websites. Ad-blocker
not required (so no need for
websites to guilt-trip you about
that). Just point your pc's DNS
Server at the IP of your Pi and abbra-ca-dabra!

EBOOK SERVER
I love to read, and I have built up
a nice collection of DRM free
eBooks, comics and PDF's through
the years. Getting them to my
various devices has always been a
bit of a hassle. Perusing folders full
of ePubs and pdfs, and having to
scoop down to the level of actually
using a usb cable to get content
over, is too shameful for me. For a
while, Calibre was a great tool to
have a powerful eBook web server
up and running. But uBookquity is
full circle magazine #159

just as good if you need something
simple. In short: A web server that
allows you to browse through and
download your comics, ebooks and
pdfs in any format you desire (oh,
and regular ﬁles too!). Sweet,
simple and password protected.

SYNC-THING
When you are a cross platform
user who hops around among Mac,
Linux and Windows machines, it’s
hard to ﬁnd a decent solution to
keep a folder in sync. Dropbox was
a nice alternative (if you trust
them), but their 3-device limit that
allows you to sync your ﬁles to only
3 devices oﬄine is a bit of a hassle.
Sync-thing does the same thing but
without having to rely on "the
cloud" as yet another repository
for your ﬁles. One folder on my
Dietpi is the "master folder" and all
other machines use the sync-thing
client to sync from there.

WHAT ELSE IS POSSIBLE?
There are plenty of other
applications and services to choose
from. Enabling too many might be a
little hard for your Raspberry Pi to
handle, so you might have to "pick
and choose" a little. On most
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accounts, these diﬀerent services
work perfectly side-by-side. I love
this since it turns your singlepurpose-cheap-computer into a
multi-purpose micro-server. If you
are brave (I don't recommend nor
discourage this), you might want to
set up the holy-trinity of piracy:
Sonarr Radarr and Laydar that
automatically torrent all the Music,
movies and TV shows you desire
(fully automated) to your Pi. Fire up
the Plex server (also a one-clickinstall) and you will be streaming
the content straight to every
screen in your home. But
remember: you will be waving the
pirate ﬂag at your own peril if you
do so.

DOCUMENTATION
Documentation on the Dietpi is
excellent because it is SHORT. No
pages and pages of monotype
fonts lulling you to sleep with
technical details: just a simple
website with a comprehensive list
of all the services you can install
(and de-install) at your own leisure.
How do you install them, what do
they do, and how do you use
them... Boom.. That's it.
I was even more amazed by
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Dietpi when I found out that you
could also install it on OTHER
platforms. Plenty of Single-board
platforms are supported AND you
can even run it on I386 platforms.
Run Dietpi on that old laptop you
have lying around with the broken
screen and, before you know it, you
will have a super-simple but superpowerful machine in your home,
even without 'a slice of pi'...

THE OFFICIAL FULL CIRCLE APP FOR UBUNTU TOUCH - UPDATED!

B

rian Douglass has updated his
FCM app for Ubports Touch
devices that will allow you to view
current issues, and back issues, and
to download and view them on your
Ubuntu Touch phone/tablet.

INSTALL
Either search for 'full circle' in the
Open Store and click install, or view
the URL below on your device and
click install to be taken to the store
page:
https://uappexplorer.com/app/
fullcircle.bhdouglass

LINKS
The Dietpi Website:
https://dietpi.com/
The Dietpi Software list:
https://dietpi.com/phpbb/
viewtopic.php?t=5

HUGE thanks to Brian for this.
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Write For Full Circle Magazine

Written by Ronnie Tucker

GUIDELINES

T

he single rule for an article is
that it must somehow be
linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc).

RULES
• There is no word limit for articles,
but be advised that long articles
may be split across several issues.
• For advice, please refer to the
Oﬃcial Full Circle Style Guide:
http://bit.ly/fcmwriting
• Write your article in whichever
software you choose, I would
recommend LibreOﬃce, but most
importantly - PLEASE SPELL AND
GRAMMAR CHECK IT!
• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Oﬃce)
document.

• Images should be JPG, no wider
than 800 pixels, and use low
compression.
• Do not use tables or any type of
bold or italic formatting.

If you are writing a review,
please follow these guidelines :

When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS
If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you access
to the raw text to translate from.
With a completed PDF, you will be
able to upload your ﬁle to the main
Full Circle site.
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REVIEWS
GAMES/APPLICATIONS
When reviewing games/applications please state clearly:
•
•
•
•
•
•
•

title of the game
who makes the game
is it free, or a paid download?
where to get it from (give download/homepage URL)
is it Linux native, or did you use Wine?
your marks out of ﬁve
a summary with positive and negative points

HARDWARE
When reviewing hardware please state clearly:
•
•
•
•
•
•
•

make and model of the hardware
what category would you put this hardware into?
any glitches that you may have had while using the hardware?
easy to get the hardware working in Linux?
did you have to use Windows drivers?
marks out of ﬁve
a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
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Ubuntu Unity 20.04

Written by Adam Hunt

A

fter his obituary was published
in the New York Journal in
1897, American writer Mark Twain
famously wrote, “the report of my
death was an exaggeration.” The
same could be said for Unity, the
user interface created by Canonical,
and ﬁrst ﬁelded as the default
interface in Ubuntu 11.04. The
project was intended to lead to
Unity version 8, the holy grail of
interfaces that would run on
everything from cell phones,
tablets and laptops to desktops as
part of a goal of “convergence”.

happy with the switch to Gnome 3,
but not all. Some Unity fans are still
using Ubuntu 16.04 LTS, which is
the last oﬃcial Unity-based release
that is still supported, with updates
being provided until April 2021. As
it is still in the repositories, some
users have just installed Unity 7 on
newer Ubuntu releases, too.

After Unity development was
canceled, there were stirrings. The
UBports community took over the
development of Unity 8 as the
interface for the Ubuntu Touch
phone operating system. There
were also indications that several
developers intended to put out a

new desktop ﬂavor of Ubuntu with
Unity 7, the last fully developed
and operational version, as used in
Ubuntu 17.04. The tech media even
reported in 2019 that Canonical
had given its blessing to such
endeavors, including the use of
trademarks for such a distribution,
an altruistic move on the

Instead, Unity was axed after its
ﬁnal appearance in Ubuntu 17.04,
as Ubuntu moved to Gnome 3 and
its Gnome Shell interface, a move
that ended the convergence dream
and marked an attempt to reign in
developer costs, too.
It seemed that Unity, which
many Ubuntu users and developers
grew to appreciate and even love
for its keyboard-centric, eﬃcient
workﬂows and clean interface, was
to be relegated to the proverbial
“dustbin of history”. Today, there
are some Ubuntu users who are
full circle magazine #159
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company’s part.
These rumblings hadn’t
produced many tangible results
until recently, with the release of
Ubuntu Unity 20.04 LTS, an
unoﬃcial Ubuntu “ﬂavor” that
combines the best of Ubuntu 20.04
LTS with the Unity 7 interface.

DEVELOPMENT
What is probably the most
remarkable aspect of this story is
that this Ubuntu remix is
developed by an Ubuntu team
member, Rudra Saraswat, who is
also a Linux Foundation Certiﬁed
Developer. He lives near New Delhi,
India and is ten years old. He
started using Ubuntu 17.04 with
Unity 7 when he was eight years
old. He really liked it, was
disappointed when it was
discontinued, and decided to bring
it back. This isn’t his ﬁrst eﬀort in
putting together a Linux operating
system, as he has previously built
several, including Krob Linux for
servers.

manager, as it is a fork of Nautilus
that reincorporated many of the
needed features that Nautilus
dropped a few years back such as
an “up one level” button and “open
as root”. Nautilus is still included by
default, as I suspect it cannot be
easily removed from the Gnome
desktop without breaking things,
but Nemo is the ﬁle manager of
choice on the Unity launcher and is
a better ﬁle manager than Nautilus
anyway.

Saraswat also eschewed
Ubuntu’s Gnome Display Manager
and replaced it with LightDM
instead, which provides the Unity
sign-in. He designed a new logo
and new wallpaper which gives
Ubuntu Unity its own distinctive
“Ubuntu family” look. Otherwise,
the release is fairly “stock” and
Unity 7.5.0 is little changed from its
Ubuntu 17.04 days.

There are future plans for this
distro, as Saraswat is hoping that
Ubuntu Unity will be accepted as
an oﬃcial Ubuntu ﬂavor. He has
positioned this ﬁrst release with
that aim, including using no outside
PPAs or non-free applications.
The 7 May, 2020 Ubuntu Unity
20.04 LTS release actually garnered
quite a bit of attention from the
tech press, with write-ups in Forbes
and TechRepublic, among others.

Saraswat engaged in a number
of Twitter surveys of Ubuntu users
to create this new distribution. He
decided to go with Nemo as the ﬁle
full circle magazine #159
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GETTING UBUNTU UNITY
Getting a copy of Ubuntu Unity
20.04 LTS is easy as the oﬃcial
website provides links to two http
download sites plus a bit torrent
site. ISOs and MD5Sums are
available for 20.04 and for the
alpha of the upcoming 20.10
release as well.
Once the 3.1 GB ISO ﬁle was

downloaded, I used the Startup
Disk Creator to write it to a USB
stick and booted to it, which all
worked ﬂawlessly.

TRYING IT OUT
If you have ever used a past
Ubuntu release with Unity, then
the boot-up leaves you in very
familiar territory. The Unity
launcher is on the left side of the
screen. Everything looks and works

just as you left it, three years ago,
with no dust on any of the
components. It is quickly apparent
that this is not a “nostalgia
project”, this is a functional,
modern desktop.
The Unity dock includes
commonly used applications and is
easy to conﬁgure. Hitting the
“super key” (Windows key) brings
up the dash menus and the “alt”
key gives instant access to the

“HUD” – the menu search that
makes Unity so fast – while keeping
your ﬁngers on the keyboard.
Immediately it all comes back
while using the desktop: the clean
interface and the eﬃcient
workﬂows. Everything just works
here and smoothly too, with no
rough edges.

SETTINGS
These days Ubuntu’s
mainstream release has only three
window themes, while Ubuntu
Unity provides a choice of ﬁve: the
default Yaru theme with Papirus
icons, plus Adwaita, Ambiance,
Radiance and High Contrast.
Ambiance and Radiance are the
classic dark and light Ubuntu
themes that will look very familiar
to any longtime Ubuntu user.
The settings available allow
some degree of customization,
making the launcher icons bigger
or smaller, choosing new wallpaper
and other tweaks that make it feel
like home again. The whole Ubuntu
Unity experience has a great
feeling of familiarity to it for
anyone who used Ubuntu between
2011 and 2017.
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APPLICATIONS
Some of the applications
included with Ubuntu Unity 20.04
LTS are:
Cheese 3.34 webcam application
CUPS 2.3.1 printing system
Document Viewer (Evince) 3.36.0
PDF viewer
Document Scanner (Simple Scan)
3.36.0 optical scanner
Files (Nautilus) 3.36.2 ﬁle manager
Firefox 76.0.1 web browser
Geary 3.36.1 email client
Gnome Calendar 3.36.1 desktop
calendar
Gnome Disks 3.36.1 disk manager
Gnome Terminal 3.36.1.1 terminal
emulator
Gparted 1.0.0 partition editor
Image Viewer (Eye of Gnome)
3.36.1 image viewer
LibreOﬃce 6.4.3.2 oﬃce suite
Nemo 4.4.2 ﬁle manager
PulseAudio 13.99.1 audio
controller
Remmina 1.4.2 remote desktop
client
Rhythmbox 3.4.4 music player
Shotwell 0.30.8 photo manager
Startup Disk Creator 0.3.7 (usbcreator-gtk) USB ISO writer
Text Editor (gedit) 3.36.2 text
editor

Thunderbird 68.7.0 email client
Transmission 2.94-2 bittorrent
client
Ubuntu Software (Gnome
Software) 3.36.0 package
management system
Videos (Totem) 3.34.1 movie player

The included Gnome Software
store provides both snap and deb
ﬁles in many cases, giving users a
choice of packages. For instance,
Filezilla and Epiphany are available
in both formats, while Chromium is
available only as a snap package.

Ubuntu Unity follows Ubuntu’s
lead in including a webcam
application, Cheese, while omitting
a default CD/DVD burning
application. This makes eminent
sense in 2020, as computers have
not had optical drives for a long
time. If required, there are good
choices in the repositories that can
be installed for CD/DVD burning
such as Brasero, K3B, and Xfburn.

CONCLUSIONS

Ubuntu Unity 20.04 LTS includes
almost all the components of
LibreOﬃce 6.4.3.2, missing only
LibreOﬃce Base, the database
application, which can be added if
needed.
Oddly, the Ubuntu Unity 20.04
LTS ISO includes two email clients,
Geary 3.36.1 and Thunderbird
68.7.0, which may help explain the
operating system's rather large 3.1
GB download size, some 600 MB
bigger than Ubuntu's 2.5 GB
download.
full circle magazine #159

As in the case of Mark Twain in
1897, today Unity seems to be far
from dead and still has an
enthusiastic following.

Shell.
There seems to be lots of
excitement around this release
within the user base and that
hopefully indicates that Ubuntu
Unity will be around for a while.
And, who knows, perhaps Ubuntu
with Unity will even become an
oﬃcial ﬂavor, like it used to be.

Oﬃcial website:
https://ubuntuunity.org/

For Ubuntu users who ran the
Unity versions of Ubuntu in the
past and ﬁnd the Gnome 3 desktop
falls short, then Ubuntu Unity
20.04 LTS will feel like coming
home again. It is still fast, eﬃcient,
modern, and clean, with a good
degree of customization available.
In fact, with more themes available
out-of-the-box, it is more
customizable. This is not beta
software either; it is ready for daily
use right from ﬁrst boot.
This release can’t be termed
“groundbreaking” or “a gamechanger”, but it does show exactly
where the mainstream Ubuntu
could have been today if it had not
left Unity 7 behind for the Gnome
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Adam Hunt started using Ubuntu in
2007 and has used Lubuntu since
2010. He lives in Ottawa, Ontario,
Canada, in a house with no Windows.
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LETTERS

If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org.
PLEASE NOTE: some letters may be edited for space.

Join us on:
facebook.com/
fullcirclemagazine
twitter.com/#!/fullcirclemag
linkedin.com/company/fullcircle-magazine
ubuntuforums.org/
forumdisplay.php?f=270

FULL CIRCLE NEEDS YOU!
Without reader input
Full Circle would be an
empty PDF ﬁle (which I don't
think many people would ﬁnd
particularly interesting). We are
always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help ﬁll the magazine.
See the article Writing for Full
Circle in this issue to read our
basic guidelines.
Have a look at the last page of
any issue to get the details of
where to send your
contributions.
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Q&A

If you have a Linux question, email it to: questions@fullcirclemagazine.org,
and Erik will answer them in a future issue. Please include as much
information as you can about your query.

Compiled by EriktheUnready

W

elcome back to another
edition of Questions and
Answers! In this section, we will
endeavour to answer your Ubuntu
questions. Be sure to add details of
the version of your operating
system and your hardware. I will try
to remove any personally
identiﬁable strings from questions,
but it is best not to include things
like serial numbers, UUID’s or IP
addresses. If your question does
not appear immediately, it is just
because there is such a lot, and I do
them ‘ﬁrst-come-ﬁrst-served’.

I

am a certiﬁed SUSE
Administrator, but I don’t use it
as my desktop any more.
I like SUSE Linux, green desktop
and all. I like the chameleon
mascot, what’s not to like? As a kid,
I used to love walking the long
hedgerows of the cemetery
looking for chameleons. I will try
SUSE again, every few years, but, as
usual, I end up disappointed. This
time, I spotted Gecko Linux,
promising to ﬁx all the ‘broken’
parts of SUSE. I opted for the XFCE
version, just to ﬁnd it more broken

than SUSE itself. I ﬁred up YAST.
Cute aardvark! Installed something,
update completed, booted, and...
broken system? Really? Reinstalled.
Tried to add GIT. To install GIT, it
needs to uninstall, say, my media
players and oﬃce? (can’t
remember the precise details).
Really? Try it on another machine
that dual-boots. It won’t ﬁnd the
other partitions. I open a ticket on
github, the answer is, yes, it’s a
bug, but it will be ﬁxed in two
years. So I try ‘tumbleweed’
instead. Black screen after ﬁrst
update. Previously on my Clevo
laptop, SUSE could never work the
sound card... So why is Ubuntu so
popular? You tell me. Not once
(touch wood) have I run into
dependency problems with
Ubuntu. Nothing I have tried to
install from the software centre
has tried to uninstall something
else I need. Love it or hate it, but
Ubuntu has made Linux accessible
to the unwashed masses. [ike me].

can I use MS paint or do I need
things like DXVK? Please don’t
make it diﬃcult.

A

: Are we talking MS paint or XP
paint? It seems someone
misinformed you. WSL allows you
to load Linux on a Windows
machine. Think of it like WUBI.
DXVK allows directx on vulkan.
May I suggest looking at: Tux paint,
Gnome paint, gpaint aka gnupaint,
Pinta, xpaint, cinepaint,
kolourpaint, mtpaint, heliospaint
and drawing? (Mypaint may be back
soon). If all this fails, PlayonLinux is
your go-to.

use WINE, but then where do the
ﬁles go?

A

: ‘Best’ is subjective, but you do
have a few choices in Ubuntu.
They can be simple, like
Transmission, or you can look at
Deluge, qbittorrent, Tixati or Vuze.
See which you like best. See here:
https://fossbytes.com/bestutorrent-alternatives/

Hello friends, I am a
Q :developer,
who wants to learn
Web pages. Only having Ubuntu
desktop. How to make a web
server?

Where can I get some free
Q :Ubuntu
books?

A

A

python -m http.server 8080

: Look here: https://
www.ubuntufree.com/
download-ubuntu-ebooks-andlinux-it-ebooks/

: The simplest way I can think
of is using Python. Simply open
a terminal and type:

This will create a simple server
for you at port 8080.

I miss MS paint from my XP
Q :machine,
back when I used to

day, I am a convert from
Q :theGood
: I am really going to miss
Windows world. What is
Q
Windows 7. I have heard only
the best torrent client for Ubuntu,

use windows. With WSL out now,

as utorrent is not a thing, I see. Do I
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bad things about Windows 10. So I
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decided the safest option would be
Ubuntu. I feel kinda dumb though,
never having used Linux before.
Should I rather go for something
else, or stick it out?

A

: Yes, Windows 10 IS bad, even
the browsers ﬁngerprint you
before the websites do. LOL. You
can look here: https://ubuntu.com/
blog/how-to-upgrade-fromwindows-7-to-ubuntu-desktoptour-and-applications - Once you
get the hang of it, you will not
want to go back.

Can you help me? I have
Q :installed
Ubuntu Mate on my
Raspberry PI 3b+ but it is slow.
How can I speed it up? <image>

A

: The PI 3 does not have the
RAM needed. Yes, it has
enough for the OS, but you need to
do things with the OS. This is where
the problems start (eg, browsing,
movies). May I suggest sticking
with Raspbian, or Ubuntu core. If
you are planning to use it as a
desktop, may I suggest trading it in
for a PI 4, the 2GB one is currently
$35. This is just too broad for a
QnA. (But keep your peepers
peeled to the magazine).

Let me explain why I need it
Q :ﬁrst.
I have a Huawei 3g dongle
and cellular data as my primary
internet. I live in the rural North
West. Unlike other people, I can’t
stream Youtube. I grab some music,
then I make my own playlists for
later. This way I can listen to it over
and over without incurring the data
cost. But, lately, youtube-dl has
stopped working for me. What
alternative is there? Thank you for
your time.

A

: Know that youtube-dl needs
to be updated like any other
program, to keep up with Google’s
changes. Simply type
sudo youtube-dl -U

and you should be on your way.
stuck on 17. I have
Q :runMyallkodimyisupdates,
but I can’t
seem to update to 18. I am still
using Xubuntu 18.04. I suspect that
this is the problem, but I don’t
wanna upgrade until 20.04 is
released. I am not sure of myself
enough to build from source. What
are my options? I am not too keen
on plex.
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A

: Just add the PPA and it will
update with the rest of your
system. See: http://
ubuntuhandbook.org/index.php/
2020/03/kodi-18-6-available-installppa-ubuntu-18-04/

I have a Dell T410 with
Q :Ubuntu,
19.10 or 18.04, it
doesn’t matter. I bought 3 8TB
drives, but I can’t seem to format it
to 24TB. I think I may need
ﬁrmware for my sas6/ir Raid card or
even my server. Maybe I need to
swap my WD red drives for
Seagate, but I need to know soon
as I can’t return the drives if I keep
them. How can I resolve this?

A

: Sorry to be the bearer of bad
news, but your controller does
not support drives larger than 2TB.
It’s a hardware problem.

Steve Morgan, [In reply to
Q :EriktheUnready],
Where can I
buy a linux laptop? Something that
is preconﬁgured and set up for me.
Would prefer a rolling release.

A

: See: https://
www.2daygeek.com/buy-linuxlaptops-computers-online/
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I am not a spring chicken any
Q :more,
so be gentle. I decided to
purchase a USB dongle to format
my phone’s SD card. I think I have
run into a chicken and egg
situation. I can’t see my SD card
without mounting it, and I can’t
format it while mounted. See what
I am saying?

A

: Actually I am going to be
brutal! Brutally honest.
Mounting a drive creates a link in
your ﬁlesystem under /mnt or /
media. You need to unmount the
drive to speak to the drive directly,
so to speak. Alternatively, you can
use the “disks” application that
ships with Ubuntu to format your
cards. If that fails, Gparted is a
good fallback.

I tried the unoﬃcial cinnamon
Q :ﬂavor
of ubuntu, but it takes
ages to boot. Can you help me?

A

: I can, if you would give me
more information. Let’s start
with: sudo systemd-analyze blame Look at what is eating up your boot
time. Next, run dmesg | less - and
see if there are any errors. A good
idea is to turn oﬀ things in your
contents ^

Q&A
BIOS that you do not use, like
serial / parallel ports. Hope this
helps!
What is the proper way to say
Q :Ubuntu?
I hear so many
versions?

A

: This I am fully qualiﬁed to
help you with. “Ooh-boon-too”.
We say abantu (people) “ah-buntoo”. Don’t mix the two like
ignorant YouTubers and say “oohbun-too”.

My usb 3g dongle from
Q :<removed>
works rather well
under Ubuntu. I dual-boot into
Windows 10, and there it does not
work. I had no issues with Windows
7. Where can I check in Ubuntu
what drivers it uses to get it
working in Windows?

A

: You are approaching the
problem from the wrong side.
To get those dongles to work in
Windows 10, will require you to
ﬂash the ﬁrmware / image on
there. The problem is that you may
lose Ubuntu compatibility, so take
it to the cellphone provider and let
them conﬁrm it will work with both
OS’s and have them ﬂash it for

you.

Q

: What is the best way to make
my own icons for Ubuntu
please? There are some icon packs I
like, but they are not 100% what I
was looking for. This is my fav at
the moment. <image>

A

: Make a base icon in Inkscape /
Gimp / Gravit, then, for each
new icon, simply add a new layer
and add your design. Layers can
usually be made invisible allowing
you to turn them oﬀ and on at will.
This way you will have consistency.

Bru, how do I change a default
Q :app
that is not in the little list?
Windows control panel has a
default app setting for all the apps,
but Ubuntu only has a few. thanks

A

: Ubuntu is intelligent. *wink.
When you right-click a ﬁle in
Linux, and choose “open with”, that
program will be associated with
your ﬁle. Linux does not use ﬁle
extensions, that is why there is no
exhaustive list like in Windows. At
any time, type: ﬁle - and the name
of your ﬁle, in the terminal and
Ubuntu will identify it for you,
regardless of extension.
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Thanks for the help you have
Q :given
me before. I am using
Ubuntu 18.04. I did not change
Writer settings. Some days ago, it
opened with two pages next to
each other. Now, after many hours
trying to ﬁx it with no luck, in Tools
settings it shows one column and it
is so, but two pages next to each
other. If the pages are normal, you
can’t see the info on the ﬁrst page.
You go down at the bottom and
there is a thin orange line you have
to drag to the side to move the
page in view. Then to view page
two you drag it to the other side. I
am so confused. If you make the
pages smaller you can see two
pages next to each other but the
fonts/writing font size 14 is so
small you can’t read it.

A

: At the bottom-right of
LibreOﬃce writer, you should
see the zoom slider. Right next to
it, you should see the layout
options. It is not uncommon to
accidentally click one of them.
Erik has been in IT for 30+ years. He
has seen technology come and go.
From repairing washing machine
sized hard drives with multimeters
and oscilloscopes, laying cable, to
scaling 3G towers, he's done it.
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Mable And The Wood

Written by Erik

Website:
http://mableandthewood.com/
Price: +- $10 on Steam, and about
$12 on GOG.

B

lurb: “Mable & The Wood is a
Metroidvania where you hunt
down massive beasts and, upon
destroying them, shapeshift into
their forms in order to use their
powers to save or destroy the
world. Players with less violent
intent can ﬁnd secret paths to
complete Mable without killing
anything, including bosses.“

kill bosses, their powers actually.
Megaman anyone? There are
abilities like mole-form, stoneform, and ghost-form, to name a
few.
You can supposedly ﬁnish the
game without violence, but it is not
clear how. With these powers you

gained after killing a boss, you can
supposedly go back and access
areas that you could not before.
How you are supposed to do this is
also a mystery. Lots of areas look
the same, and the map is not the
best. The pixel art in the game is
good, not great. Though there are
lots of animations for diﬀerent

characters, I feel the art could have
used just a bit more polish. The
minimalism loses its charm after a
while. The level design and coloring
is top notch, and you can see a lot
of thought went into the palette.
The only thing missing is distinct
areas / architecture / backgrounds
so you can remember where you

You play Mable, a young girl,
resurrected by a cult to stop the
end of the world. Revenant
anyone? The twist: Mable cannot
do anything in human form, she
cannot jump, or run, let alone ﬁght.
All of these things can be
accomplished by her shape
changing. There is a restriction on
these abilities though, Mable has a
power meter. So, in your Spiderman
form, you shoot webs and swing
around (sorry spider form. Winkwink), but you cannot do it all the
time. You gain more powers as you
full circle magazine #159
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were and are going. The sound
feels like it was made for a console
though. It comes across as basic. I
understand that it is the theme,
basic pixel art, basic sound design,
but it is like eating fries that need
more salt. That said, it is a perfect
ﬁt and has no repeats that work
your last nerve. Even with
headphones on and doing
something repetitive, I never tired
of the sound.

However I did have issues with
the playability. It seems there are
still bugs to be sorted. Some spots
are horrible. In some places, the
collision detection blows, allowing
you to move through solid objects.
Anything with an angle seems to be
a problem for the engine. In some
places, sound is just missing. A ﬁre
will be silent or a creature will be.
Your grave site that allows you to
recover your goodies sometimes
appears and sometimes not, and

sometimes behind a solid wall you
cannot reach. You can not only get
lost back-tracking, you can also get
stuck. The only option is to start a
new game. You don’t always know
if what you did was correct or a bug
(ahem, feature). The twist being
the hook of the game, will hook
you. Though it was advertised as
metroidvania, it is not quite, but it
is addictive. I just think it came out
of Steam greenlight a little too
soon. That said, the developers are

actively ﬁxing, and there are lots of
updates. The game has a lot of
potential and a lot of room for
improvement.
Compared with modern games,
it is not big, being about a 600MB
download. However, if I compare it
to, say, a game like Prehistorik2
that came on a few (or was it one?)
stiﬀy’s, it could be a lot smaller.
Optimising space is also not the
only issue; in some places you may
see some slow-downs. A game like
this, in 2020, should not have
those. I almost want to say the
game feels somewhat like a gamejam game that you would ﬁnd on
itch.io.
If this was polished to shine, it
would be one of those outstanding
games you see every so often, but,
as it stands now, is meh.

Erik has been in IT for 30+ years. He
has seen technology come and go.
From repairing washing machine
sized hard drives with multimeters
and oscilloscopes, laying cable, to
scaling 3G towers, he's done it.
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PATRONS
MONTHLY PATRONS
Alex Crabtree
Alex Popescu
Andy Garay
Bill Berninghausen
Brian Bogdan
CBinMV
Darren
Dennis Mack
Devin McPherson
Doug Bruce
Elizabeth K. Joseph
Eric Meddleton
George Smith
Henry D Mills
Hugo Sutherland
Jack
Joao Cantinho Lopes
John Andrews
John Malon
John Prigge
Jonathan Pienaar
JT
Kevin O'Brien
Lee Allen
Leo Paesen
Linda P
Mark Shuttleworth
Norman Phillips
Oscar Rivera
Paul Anderson

Paul Readovin
Rob Fitzgerald
Roy Milner
Scott Mack
Sony Varghese
Tom Bell
Tony
Vincent Jobard
Volker Bradley
William von Hagen
Taylor Conroy

Glenn Nelson
The current site was created thanks to
Lucas Westermann (ex-Command &
Conquer) who took on the task of
completely rebuilding the site, and
scripts, from scratch, in his own time.
The Patreon page is to help pay the
domain and hosting fees. The yearly
target was quickly reached thanks to
those listed on this page. The money
also helps with the new mailing list that
I set up.
Several people have asked for a PayPal
(single donation) option, so I’ve added a
button to the right side of the website

SINGLE DONATIONS
2020:
alex moro
Ronald Eike
ALEXANDRU POPESCU
Linda Prinsen
Glenn Heaton
Jon Loveless
Frank Dinger
Raymond Mccarthy
Daniel Rojo
Frits van Leeuwen
Peter Swentzel
Anthony Cooper
Dale Reisﬁeld
Gavin Thompson
Brian Kelly
Ronald Eike
Michael Grugel
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A big thank you to all those who’ve
used Patreon and the PayPal button.
It’s a HUGE help.

https://www.patreon.com/
fullcirclemagazine

https://paypal.me/ronnietucker

https://donorbox.org/recurringmonthly-donation
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HOW TO CONTRIBUTE

Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org
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FULL CIRCLE NEEDS YOU!
A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's, reviews,
and anything else you want to tell your fellow *buntu users. Send your
articles to: articles@fullcirclemagazine.org

Deadline:
Sunday 09th Aug. 2020.
Release:
Friday 28th Aug. 2020.

We are always looking for new articles to include in Full Circle. For help and advice please
see the Oﬃcial Full Circle Style Guide: http://bit.ly/fcmwriting
Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our site via: fullcirclemagazine.org

Webmaster admin@fullcirclemagazine.org
Editing & Proofreading
Mike Kennedy, Gord Campbell, Robert
Orsino, Josh Hertel, Bert Jerred, Jim
Dyer and Emily Gonyer
Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

Getting Full Circle Magazine:
For the Full Circle Weekly News:

EPUB Format - Most editions have a link to the epub ﬁle on
that issue's download page. If you have any problems with
the epub ﬁle, email: mobile@fullcirclemagazine.org

You can keep up to date with the Weekly News using the RSS
feed: http://fullcirclemagazine.org/feed/podcast
Or, if you're out and about, you can get the Weekly News via
Stitcher Radio (Android/iOS/web):
http://www.stitcher.com/s?ﬁd=85347&reﬁd=stpr

Issuu - You can read Full Circle online via Issuu:
http://issuu.com/fullcirclemagazine. Please share and rate
FCM as it helps to spread the word about FCM and Ubuntu.

and via TuneIn at: http://tunein.com/radio/Full-Circle-WeeklyNews-p855064/

FCM PATREON : https://www.patreon.com/fullcirclemagazine
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